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Introduction
The STD template is a wizard to be used with Microsoft Word 97, Microsoft Word 2000 and Microsoft Word XP
(2002) for the preparation of ISO and ISO/IEC International Standards, Technical Reports, International
Standardized Profiles, Technical Specifications, Publicly Available Specifications and Guides. It automatically
creates the cover sheet of these documents, their foreword, headers and footers, and inserts a style sheet to
facilitate the creation of the rest of the document. It may also be used to prepare Amendments and Technical
Corrigenda to these documents.
The STD template, version 2.1, is in conformity with the ISO/IEC Directives, Part 2[1], 2001. It replaces STD 2.0
which was in conformity with the ISO/IEC Directives, Part 3[2], 1997. Additional changes are as follows: the “Insert”
button of the STD toolbar has been renamed as the “Elements” button to avoid any confusion with the “Insert”
menu of the Standard toolbar; the styles Body Text, for use in tables, have been renamed as Table text (see
5.3.11.3); the gutter has been increased by 7 mm to give an inside margin of 25 mm.
Annex A summarizes the various ISO templates.

iv
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Version 2.1 — Reference manual

1

Scope

This reference manual provides standards writers with information for the preparation and formatting of ISO and
ISO/IEC International Standards, Technical Reports, International Standardized Profiles, Technical Specifications,
Publicly Available Specifications and Guides using the STD template, version 2.1 (STD 2.1 template).
The STD 2.1 template can be used with Microsoft Word 97, Word 2000 and Word XP (2002)1), under Windows 95
[OEM Service Release 2 (OSR2) recommended], Windows 98, Windows Me, Windows NT4.0 [Service Pack 3
(SP3) recommended], Windows 2000, or Windows XP. [For those people using the Japanese versions of Word
and Windows, note that this version 2.1 works with Word 2000 (it has been tested under Word 2000 and
Windows 98) but not with Word 97.] It has not been tested with other versions of Word or other operating systems.
It cannot function in non-VBA (Visual Basic for Applications) environments. The minimum hardware configuration is
a PC-compatible computer equipped with at least a 133 MHz Pentium-type processor, at least 10 Mbyte of hard
disk space free, a colour screen compliant with SVGA standard (minimum resolution: 800 ¥ 600) and at least
16 Mbyte RAM (24 Mbyte or 32 Mbyte recommended).
NOTE 1

This version 2.1 is in conformity with the ISO/IEC Directives, Part 2, 2001[1].

NOTE 2

This reference manual was prepared using the STD template.

NOTE 3

Known problems with the template and their solutions are detailed in Annex B.

NOTE 4
Office, Visual Basic, Windows and Word are registered trademarks of Microsoft Corporation. Pentium is a registered
trademark of Intel Corporation.

2

Installation of the template

IMPORTANT — If you are using Windows on a network, do not perform the installation yourself; ask your
network administrator.
The STD template has been adopted by certain standards bodies for the preparation of their national and
regional standards. European users are advised to consult their member body or the CEN Management
Centre for details of how their national or regional standardization systems respectively can be accessed.
The STD template is supplied as a compressed archive file (ZIP file) containing the template itself (file STD.DOT)
and a setup file (file STD.INI).
To install the template, download the archive to a folder of your choice on the hard disk of your computer. In Word,
find the locations specified for the “User” templates and “Workgroup” templates (in the “Tools” menu, choose
“Options” and note the “Location” specified in the “File Locations” tab). Extract the file STD.DOT from the archive,

1) The instructions given in this manual are not fully adapted for use of the template with Microsoft Word XP (2002). Users of
this version of Word are advised to inform themselves of any version-specific differences and to take into consideration any
adaptations necessary. Furthermore, a number of known problems affect the use of the template with Word XP (2002); these
problems are detailed in B.4.
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and save it to one of these locations or to one of their subfolders (it may be preferable to create a new subfolder
especially for the STD template). Extract the file STD.INI from the archive and save it in the Windows folder of your
computer (usually C:\WINDOWS if you use Windows 95, Windows 98, Windows Me or Windows XP, or C:\WINNT
if you use Windows NT or Windows 2000).
CAUTION — The template requires write access to the STD.INI file. Check that the Windows folder of your
computer is not write-protected; if it is, contact your network administrator.

3

Creating a new document based on the STD template

NOTE

In the following, the template is assumed to have been installed in one of the locations specified in Clause 2.

Start Word. In the menu bar select “File” and “New...”.
In the “New” dialogue box, choose the “General” tab or the tab corresponding to the subfolder in which you
installed the template in Clause 2. Be sure that under the option “Create New” that “Document” is selected and not
“Template”. Click once on the icon “Std.dot” then click on “OK”, or alternatively double click on “Std.dot”. See
Figure 1.
A blank document will appear on the screen and the software will display the STD toolbar (see 4.1.1).

Figure 1 — Getting started on the template

2
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4

Features of the template

4.1
4.1.1

User interface
STD toolbar

Once the template is opened, a supplementary toolbar is displayed: this is the STD toolbar (see Figure 2) which
can be used to perform most of the functions of the template.

Figure 2 — STD toolbar
The “Doc.Info” button opens the STD manager which is used to create a new document and to manage the
administrative information entered (reference number, committees, titles, etc.). See 4.1.2.
The “Translate” button creates a new document in either English or French based on the French or English original
document respectively. However, only the basic elements of the document (cover sheet, foreword text, and titles of
framework elements) will be translated. See 4.6.
The “Elements” button displays a menu allowing the insertion of framework elements (basic clauses, annexes,
bibliography and other elements which may appear in normative-type documents — see 4.4) and other basic
elements found in normative-type documents (clauses, notes, examples, etc.) — see Figure 3.
NOTE

In STD 2.0 this button was labelled “Insert”.

Figure 3 — “Elements” button menu
The “Export” button saves the document in a different Word format (Word 2, 95 or 97). See 4.5.
The “Options” button allows the user to change the language of the user interface, including that of the dialogue
boxes. It is also possible to choose the language of the STD user interface when opening a new document from the
first dialogue box of the STD manager [see Figure 4a)].

© ISO 2002 – All rights reserved
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4.1.2

STD manager

The STD manager is the most important part of the template software. You can access it via the “Doc.Info” button
on the STD toolbar. Using this software you can create or change a document and its associated administrative
information. It contains three dialogue boxes “Parameters”, “Standardization system” and “Titles” (see Figure 4),
described in detail in 4.7, 4.2.1 and 4.2.2 respectively.

New document

Document already in the template
a) Parameters (see 4.7)

b) Standardization system (see 4.2.1)

c) Titles (see 4.2.2)

Figure 4 — “STD manager” dialogue boxes
4.1.3

Fields contained in the document

Part of the administrative information entered in the STD manager is inserted at the beginning of the document in
“SET” fields. It is imperative not to modify or delete these fields manually since this may provoke problems with the
software associated with the STD manager.
4.1.4
4.1.4.1

Colour codes used in the document
General

Certain text or portions of text appear in a colour other than black. These colours have a meaning as indicated in
4.1.4.2 to 4.1.4.4. In order to ensure that the software works correctly it is absolutely necessary to follow the rules
given in the following subclauses.

4
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4.1.4.2

Blue text

All elements which appear in blue in the document shall not be deleted or modified manually. If these data are
incorrect or no longer valid, use the STD manager (see 4.1.2) to update or to correct them.
If you use a colour printer, program it to print your document in black and white. Do not modify the colours of the
characters in your file.
4.1.4.3

Red text

For all the elements which appear in red, it is necessary to make an editorial choice, for instance


indicating the number of the edition and changes in relation to a previous edition in the foreword, or



when working in French, making a choice between the masculine or feminine gender, or



completion of text or deletion of text which is not applicable.

4.1.4.4

Green text

Notes concerning editorial drafting rules (see 4.2.5) appear in green.

4.2

Creating documents

4.2.1

Standardization system

To create a new document, open the template (see Clause 3), and change if necessary the language of the user
interface in the first dialogue box (see its use in 4.7).
Go to the second dialogue box by clicking the “Next” button. The second dialogue box displays the Standardization
system.
Enter data into the fields as explained in Figure 5. All the data in these fields can be modified after closure of the
STD manager (see 4.2.4) except two:


the “Doc. language” field;



the “Include notes on drafting” field.

Ensure, therefore, that the content of these fields is correct, and then click on the “Next” button to proceed to the
next dialogue box where you enter the titles of the document.

© ISO 2002 – All rights reserved
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1

2

5
8

3
4

9

6
7
11
10

12
13
1
2
3
4
5
6
7
8
9
10

11
12
13

number and title of the technical committee (TC) responsible for the work, and the organization providing the secretariat
number and title of the subcommittee (SC) responsible for the work, if applicable
number of the working group (WG) responsible for the work, if applicable
serial number of the working document [reference number attributed by the TC or SC secretariat (see the ISO/IEC
Directives, Supplement — Procedures specific to ISO, 2001[3], SJ.1.1.1)]
check box to insert editorial notes on drafting (extracts from the ISO/IEC Directives, Part 2, 2001[1]) when creating a new
document
document number (for instance 9000 for the standard ISO 9000)
part number, if necessary (for instance 6 for the standard ISO 2382-6)
day, month and year of the current project (by default, the current day)
number of the draft (for the second and subsequent drafts, the draft number will appear at the end of the document
reference number, for instance “ISO/CD 965-1.2” is the second draft of the document “ISO/CD 965-1”)
name of the organization (ISO or ISO/IEC), type of document (International Standard, International Standardized Profile,
Technical Report, Publicly Available Specification, Technical Specification or Guide), stage (20 to 60) and document subtype (Amendment or Technical Corrigendum)
if the Amendment or Technical Corrigendum is selected as a document sub-type (see item 10), indicate the Amendment or
Technical Corrigendum number and the year of publication of the amended or corrected document
language of the document: F for French, E for English
the “Special character” button can be used to insert symbols in the TC and SC titles; click on this button to display a dialogue
box from which you can select a symbol — note that only the font “(normal text)” can be used
NOTE

After clicking on “End” in the “Titles” dialogue box it is no longer possible to modify the document language.

Figure 5 — “Standardization system” dialogue box

6
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4.2.2

Titles

Enter, as indicated in Figure 6, the three elements of the title into the corresponding fields in each of the languages.
See the editorial rules for titles in 5.3.2.1.
Use the “Special character” button to insert symbols — see Figure 6.
NOTE 1

It is not possible to use italics or underlined characters in the elements of the title.

NOTE 2
Certain special characters which cannot be entered using the keyboard, the “Special character” button of the “Titles”
dialogue box or the “Special Characters” tab in the “Insert” “Symbols” menu can meanwhile be entered using their ASCII codes
(e.g. Alt 0160 for a nonbreaking space).
NOTE 3
There is no field to enter the title of an Amendment or a Technical Corrigendum, but see B.1.10 for how to enter
these titles.

CAUTION — Do not use quotation marks (“ and ” or « and ») in the elements of the title since the text
following the first quotation mark will not appear in the document and the title of the other elements will be
modified. Use two apostrophes (') instead of quotation marks.

1
2

3

4
1 introductory element (optional)
2 main element (obligatory)
3 complementary element (optional) or part title (obligatory) in the case of a standard in parts
NOTE
For standards in parts, enter the title of the part in the third field; omit the word “Part” and the part number, since
the template will insert them for you.

4 the “Special character” button can be used to insert symbols in the title; click on this button to display a dialogue
box from which you can select a symbol — note that only the font “(normal text)” can be used
Figure 6 — “Titles” dialogue box
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4.2.3

Replaced documents

By selecting the “Replaced documents” tab in the “Titles” dialogue box, you can enter and modify the list of
replaced documents as necessary.
The entries in this dialogue box will be used to complete the foreword text created by the template.
To enter a replaced document, select the document type in the list on the left or type it in the field above the list,
then enter the document reference number (for instance 2382-6 for the standard ISO 2382-6) in the second field,
and the year of publication in the following field; click on the “Add” button. See Figure 7.
To delete a document from the list on the right, select it, then click on the “Delete” button.
1

2

3

4

1 document type
2 document reference number (for instance 2382-6 for the standard ISO 2382-6)
3 year of publication of the replaced document
4 list of document types
Figure 7 — “Replaced documents” dialogue box
4.2.4

Confirmation of data entry

After having entered the data in 4.2.1 to 4.2.3, click on the “End” button to execute the program that creates and
updates the cover sheet, the headers and footers, and the foreword of the document.

8
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WARNING — All information can be modified afterwards with the exception of the document language (see
4.2.1) and the insertion of notes concerning editorial drafting rules (see 4.2.5).
4.2.5

Notes concerning editorial drafting rules

Notes concerning editorial drafting rules in accordance with the ISO/IEC Directives, Part 2, 2001[1], can be inserted
in the document (see item 5 in Figure 5). It is only possible to insert these notes when creating a new document.
These notes appear in green and should be deleted upon completion of your document.
A document framework or skeleton (black and red text) is inserted together with the editorial notes; it can be used
as the basis for preparing the document.

4.3

Importing files created using a different template

4.3.1

General

It is possible to import files created using a different word processor template into the STD template as long as the
file has been saved in Word 97/2000 or Word 97-2002 format. To import a file that is in another format
(Word 6.0/95 or other word processor), it is necessary first to open the file in Word 97, 2000 or XP (2002) and then
to save it in Word 97/2000 or Word 97-2002 format.
To import a file, create a new document based on the STD template as described in 4.2. Then click on the “Import”
button in the first dialogue box of the STD manager [see Figure 4a)], browse for the file to be imported using the
“Open” dialogue box then click on the “Open” button.
The STD manager opens and it is necessary to enter the following information:
a)

name of the organization;

b)

document type;

c)

document number;

d)

part number, if applicable;

e)

document sub-type, followed by the number of the Amendment or Technical Corrigendum;

f)

document language.

The program then applies the stylesheet of the STD template. The dialogue boxes of the STD manager open again
and you may then enter the remaining data for the document. (Altogether the STD manager dialogue boxes open
twice for data entry.)
CAUTION — The instructions provided above do not apply to files created using the STD template. Such
files cannot be imported, and any attempt to do so will generate an error message. Normally, on opening
such files, Word will automatically attach them to the STD template. If Word does not do this, you need to
attach them manually: in the “Tools” menu, select the “Templates and Add-Ins...” command, click on
“Attach...”, select “STD.DOT” from the list and then click on the “Open” button in the “Attach a template”
dialogue box and on “OK” in the “Templates and Add-Ins” dialogue box.
Table 1 gives a summary of the different means of importing files, previously saved in different formats or created
using another template, into the STD template.
4.3.2

Special cases: ISOSTD30 and ISOSTD33 templates

Contrary to the general case given in 4.3.1, files created using the ISOSTD30 and ISOSTD33 templates,
regardless of their format (Word 6.0, 95 or 97), will always be recognized and the corresponding fields to those in
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the STD template will be recovered. Problems related to importing files from the ISOSTD30 and ISOSTD33
templates are indicated in B.3.
4.3.3 Special cases of files created using the STD template, where the standardization system is not
available
If on opening a file, all the fields in the “Standardization system” dialogue box are dimmed, it is necessary to create
a new document based on the STD template and then to enter the relevant administrative data in the STD
manager. Next, in the source document, cut all the text following the scope and paste it into a suitable place in the
newly created template document. Follow the same procedure for the foreword and introduction as necessary.
Table 1 — Importing files created using a different template
Format

Template

Instructions

Word 2

BASICEN and BASICFR
or other

Save the source file in Word 97/2000 or Word 97-2002 format. Create a new
document based on the STD template, click on “Import”; find the file to be imported,
select it and then click on the “Open” button. (See 4.3.1.)

Word 6,
Word 95

ISOSTD30

Create a new document based on the STD template, click on “Import”; find the file to
be imported, select it and then click on the “Open” button. (See 4.3.2.)

BASICEN and BASICFR
or other

Save the source file in Word 97/2000 or Word 97-2002 format. Create a new
document based on the STD template, click on “Import”; find the file to be imported,
select it and then click on the “Open” button. (See 4.3.1.)

Word 97

ISOSTD33, BASICEN2
and BASICFR2 or other

Create a new document based on the STD template, click on “Import”; find the file to
be imported, select it and then click on the “Open” button. (See 4.3.2 and 4.3.3 for
files created using the STD template but where the Standardization system is not
available.)

Other than
Word

BASICEN2 and
BASICFR2 or other

Save the source file in Word 97/2000 or Word 97-2002 format. Create a new
document based on the STD template, click on “Import”; find the file to be imported,
select it and then click on the “Open” button. (See 4.3.1.)

4.4

Insertion of framework elements

Framework elements (basic clauses, annexes, bibliography, and other elements that may appear in normative-type
documents) can be easily inserted using the STD template by means of the “Framework element” menu opened by
clicking on the “Elements” button of the STD toolbar. These elements may include boilerplate texts. When these
elements correspond to a clause, they will be inserted in the “Heading 1” style.
To insert one or more framework elements, place the cursor at the place of intended insertion in a “Normal” style
paragraph. Click on the “Elements” button of the STD toolbar and select “Framework element”. In the “Framework”
dialogue box (see Figure 8), select the first of the elements to be added into the document from the list on the lefthand side and then click on the “Add” button to add it in the right-hand list; if necessary, enter data into the
supplementary dialogue box. Proceed in the same manner for the other elements, in the order which they should
appear in the document.
To delete an element from the right-hand list, select it then click on the “Delete” button.
NOTE 1
The “Framework” dialogue box does not show the framework already present in the document and any previously
inserted framework elements cannot be deleted using it: the list on the right-hand side is empty each time this dialogue box is
opened.
NOTE 2
The titles of elements appear in the document language selected in the “Standardization system” dialogue box (see
4.2.1) when the document was created.

10
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Figure 8 — “Framework” dialogue box

4.5

Saving files

4.5.1

Principle

Once all the administrative information has been entered for a new document and the “End” button has been
clicked, the template saves the file under a name which is generated automatically by the template from the
administrative data entered in the STD manager as follows:
a) name of the organization;
b)

indication of the type of document;

c)

document number, including the part number;

d)

letter, if applicable, representing the document sub-type, followed by the number of the Amendment or
Technical Corrigendum;

e)

letter representing the document language, in parentheses.

This file name can be altered but it is not possible to cancel the save at this moment, although it is possible to
specify the location where the file will be saved. By default this location will be the location for subsequent
sessions.
CAUTION — Unlike in STD 1.0, the file name is not generated each time that the STD manager is run. Any
correction necessary therefore needs to be carried out manually.
Known problems linked with saving files are given in B.2.
4.5.2

Exchange formats

For exchange purposes, it is possible to save a file in a different Word format, as well as with a short file name. For
this purpose, use the “Export” button (see 4.1.1 and Figure 2).
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If you are using Word 97, to save correctly files to Word 6.0/95 format, it is necessary that the binary conversion
filter to Word 6.0/95 format [converter delivered with Office 97 Service release 1 (SR-1), available from Microsoft
Corporation] is installed; otherwise the files will be saved in RTF format.
4.5.3

Use of existing files created using the STD template for preparing a new document

A file already based on the STD template can be used to create another document without having to “import” the
file. To do this, open the file, select “Save as” and enter a different file name. Click on the “Doc.Info” button then on
the “binoculars” button adjacent to the name displayed in red. You can then enter the data for the new document by
clicking the “Next” button without risk of deleting the original file.
This procedure has no effect on the original file; it is not modified, renamed or relocated.
To prepare the framework of the second language of the document, it is preferable use the “Translate” button
(see 4.6).

4.6 Translating a document for which a file based on the STD template already exists into
English or French
The STD template can translate the basic elements of an existing STD template file into English or French provided
that they were entered via the “Framework” dialogue box of the “Framework element” menu [opened by clicking on
the “Elements” button of the STD toolbar (see 4.4)].
NOTE
This function is not comparable with that of a computer-aided translation (CAT) program in that only certain
elements in one language (framework elements, foreword and the information on the cover sheet) are translated. Its benefit lies
primarily in that it prepares the draft for a “human” translator.

If the file of the document that you wish to translate has not been saved since it was last modified, save it. If the file
of the document that you wish to translate is currently closed, open it. Click on the “Translate” button. In the
“Translate to” dialogue box click on English or French as appropriate and then click on “OK”. The first dialogue box
of the STD manager will open. Use the “Next” button to check the information in the various dialogue boxes; modify
the data if necessary. Click on the “End” button to execute the program and to create a new document from the
existing one.
The new document will contain the cover sheet, the headers and footers and the foreword corresponding to the
administrative information input from the STD manager; the remaining text will not be translated from the original
language with the exception of the titles of the basic elements and any associated automatically generated
boilerplate texts added via the “Framework element” menu [opened by clicking on the “Elements” button of the STD
toolbar (see 4.4)]. The boilerplate texts of the translated document will remain and will need to be deleted.

4.7

Links between language versions

The STD template allows linking between different linguistic versions of the same document. This is managed in
the first dialogue box (“Parameters”) of the STD manager.
Click on the “Doc.Info” button. The “Parameters” dialogue box gives the name and location of any files linked to the
current file (see Figure 9).

12

© ISO 2002 – All rights reserved

STD template, version 2.1

Figure 9 — “Parameters” dialogue box
A file name may appear in red in two cases:


the name of the file has changed since it was linked (see the information used to generate automatically the
name in 4.5.1);



the file in question has been moved from one location to another since it was linked.

In both cases, clicking on the “binoculars” button adjacent to the name in red creates a link with the specified file
and displays the “Open” dialogue box. Select the file and click on the “Open” button. The file name and location of
the file selected will now appear in the field.
If the file of the different linguistic version is not indicated although it exists, it is probably because it was not
created using the “Translate” button. To link the other linguistic version, click on the “binoculars” button adjacent to
the empty field, browse to locate the file, select the file and click on the “Open” button. The file name and location
of the file selected will now appear in the field.
To synchronize the document titles in each of the two files, open the version most up to date, re-establish the links
with other files if necessary (files displayed in red or absent from the “Parameters” dialogue box) and click on the
“Synchronize” button.
Consequently, the document titles in the unopened language document displayed in the “Parameters” dialogue box
will be replaced with those which have just been defined in the open document.
CAUTION — Make sure that the synchronization is carried out from the most recent version!
The problems concerned with linking files are explained in B.2.
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5
5.1

Use of the stylesheet
General

The stylesheet is in the form of a document skeleton which contains the informative preliminary elements found in
standards (cover sheet, table of contents, foreword and introduction) as well as the first normative page containing
the scope.
NOTE 1

If editorial notes on drafting are inserted (see 4.2.5), the document will also contain examples of basic elements.

Starting from the scope, new elements may be inserted as follows:


for basic elements (clauses, subclauses, notes, examples, etc.), by choosing the element directly from the
menu of the “Elements” button of the STD toolbar (see Figure 3), or from the contextual menu (opened by
clicking on the right-hand button of the mouse);



for “Framework elements” (clauses, annexes, bibliography, etc.), via the “Framework” dialogue box (click the
“Elements” button of the STD toolbar, and then click on “Framework element”) (see Figure 8), or from the
contextual menu (opened by clicking on the right-hand button of the mouse);



for other elements, by selecting the corresponding style from the Style drop-down list in the formatting toolbar.

IMPORTANT — The “Elements” button of the STD toolbar has certain automated functionalities associated
with it (e.g. automatic inserts are programmed for certain styles). Although the complete set of available
template styles is also accessible via the Style drop-down list in the formatting toolbar and the “Style”
command of the “Format” menu, unless otherwise specified do not use these for applying styles since the
automated features will be missing; use the “Elements” button of the STD toolbar.
A summary of the template styles, including instructions for their use and their means of application, is given for
information in Annex C. A quick reference guide indicating which style corresponds to which element is given in
Annex D.
NOTE 2
A certain number of the STD template styles are based on predefined Microsoft styles. These styles are recognized
by the various linguistic versions of Word and their names will be translated automatically into the language of the Word version
which you are using. For these Microsoft styles, the user will need to derive the correspondence between the name displayed
and that given in this manual; for example, if the same document is opened using English and French versions of Word, text
styled “Footnote Reference” in the English version is called “Appel de note” in the French version (see also Annex C and
Annex D, table footnote a). The names of the other template styles are in English.

Each element is represented by a distinct style; each style has a predefined format associated with it. For example,
a term in the “Terms and definitions” clause is in boldface, and the corresponding definition is in lightface. Never
alter the predefined format associated with a style using the “Format” “Style” command. If you need to emphasize a
piece of text, use only the formatting buttons of your word processor; for example, bold, italic or underlining.
Furthermore, do not use special fonts to emphasize a piece of text.
Note that in order for a conversion process to be successful it is essential that the styles are applied consistently in
accordance with the rules given in this clause. When one element is “nested” in another, apply the predominant
style and format the “nested” element using the formatting commands of your word processor (do not use the
“Format” “Style” command). Examples of “nested” elements include notes in lists, together with lists in notes, lists in
footnotes to the text, and lists in table and figure footnotes.
Note that if you create your own styles, their conversion cannot be assured; they may be mapped to the “Special”
style (see 5.3.17) in certain conversion procedures.
The page layout and presentation should be as simple as possible. It is preferable to use a single-column page
layout than to insert manual page or section breaks. However, when for layout purposes it is necessary to create a
new section, beware that the automatic page numbering will be restarted at 1 for each section unless specified
otherwise. To avoid this, from the “View” menu, choose “Header and Footer”. In the “Header and Footer” toolbar,
click on the “Page Setup” button and deselect the check box “Different first page” in the “Layout” tab and click on
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“OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...” from the “Insert” menu. Click on
“Format…” and select the option “Continue from previous section”. Click twice on the “OK” button.
WARNING — Do not remove the section breaks already present in the document skeleton otherwise the
headers and footers will not be correct.
If the section break between sections 2 and 3 falls on an odd-numbered page, the page which follows will be blank
since the first page of section 3 has been specified to be an odd-numbered page (i.e. page 1) in the STD template.
The different styles available in the STD template are described in 5.2 to 5.4.
As far as practicable, the typography and content of the stylesheet are in conformity with the rules given in the
ISO/IEC Directives, Part 2[1]. However, for the purpose of submitting electronic files, the formatting conventions of
the stylesheet supersede those given in the ISO/IEC Directives, Part 2[1]. In the event of any contradiction in
requirements, or in the case of enquiries, please contact the ISO template helpdesk <template@iso.org>.
Although the STD template allows the creation of Amendments and Technical Corrigenda, it is not fully adapted for
the presentation of these document sub-types. Where discontinuous numbering of elements is required, it is
possible to delete the automatic numbering inserted by the template for certain styles by selecting the “Bullets and
Numbering...” command from the “Format” menu, and then clicking on “None” in the appropriate tab and then “OK”.
The required numbering can then be inserted either manually or via the “Customize” button in the appropriate
“Bullets and Numbering...” command tab.

5.2

Insertion of subdivisions

5.2.1

Clauses

5.2.1.1

Drafting rules

A clause is the basic component in the subdivision of the content of a document.
The clauses in each document or part shall be numbered with Arabic numerals, beginning with 1 for the “Scope”
clause. The numbering shall be continuous up to but excluding any annexes. Numbers given to the clauses of an
annex shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start
afresh with each annex.
Each clause shall have a title, placed immediately after its number, on a line separate from the text that follows it.
5.2.1.2

Styles

Names:

Heading 1 (in the body of the document)
a2 (in the annexes)

NOTE

See also Table 2.

Automatic numbering: yes
5.2.1.3

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Clause/Subclause with title” from the menu; select the tab (“Body” or “Annex”)
corresponding to the intended position of the clause, then click on <1> or <A.1> accordingly.
Alternatively, use the keyboard shortcut:


body of the document: Ctrl+Shift+1 or the corresponding keyboard shortcut for Heading 1 which you can find
using your software on-line help or user manual;



annex: Ctrl+2.
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5.2.1.4

Remarks

The clause number shall have the same typographic format as the clause title. If it does not, select the paragraph
mark at the end of the clause title, and then apply to it the correct format using the tools of the formatting toolbar or
reapply the corresponding style.
Hitting return after you have entered a clause will put the cursor in a new paragraph in the style ‘‘Normal”
(see 5.2.3).
The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of heading
respectively.
Certain clauses which follow specific editorial rules (see 5.3.6) can be inserted via the “Framework” dialogue box of
the “Framework element” menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)].
5.2.2

Subclauses

5.2.2.1

Drafting rules

A subclause is a numbered subdivision of a clause. A primary subclause (e.g. 5.1, 5.2, etc.) may be subdivided
into secondary subclauses (e.g. 5.1.1, 5.1.2, etc.), and this process of subdivision may be continued as far as the
fifth level (e.g. 5.1.1.1.1.1, 5.1.1.1.1.2, etc.).
Subclauses shall be numbered with Arabic numerals. Numbers given to the subclauses of an annex shall be
preceded by the letter designating that annex followed by a full-stop.
A subclause shall not be created unless there is at least one further subclause at the same level. For example, text
in Clause 10 shall not be designated subclause “10.1” unless there is also a subclause “10.2”.
Each primary subclause should preferably be given a title, which shall be placed immediately after its number, on a
line separate from the text that follows it. Secondary subclauses may be treated in the same way. Within a clause
or subclause, the use of titles shall be uniform for subclauses at the same level, e.g. if 10.1 has a title, 10.2 shall
also have a title. In the absence of titles, key terms or phrases (composed in distinctive type) appearing at the
beginning of the text of the subclause may be used to call attention to the subject matter dealt with. Such terms or
phrases shall not be listed in the table of contents.
5.2.2.2
5.2.2.2.1

Subclauses with titles
Styles

Names: Heading 2 to Heading 6 (in the body of the document)
a3 to a6 (in the annexes)
NOTE

See also Table 2.

Automatic numbering: yes
5.2.2.2.2

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Clause/Subclause with title” from the menu; select the tab (“Body” or “Annex”)
corresponding to the intended position of the subclause with title, then click on the button corresponding to the
desired subdivision level (the labels on the buttons give an example of the numbering).
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Alternatively, use the keyboard shortcut:


body of the document: Ctrl+Shift+ the number corresponding to the desired level or the corresponding
keyboard shortcut for the heading level which you can find using your software on-line help or user manual;



annex: Ctrl+ the number corresponding to the desired level plus 2 (e.g. to create A.1.1 in Clause A.1, press
Ctrl+3).

5.2.2.2.3

Remarks

The subclause number shall have the same typographic format as the subclause title. If it does not, select the
paragraph mark at the end of the subclause title, and then apply to it the correct format using the tools of the
formatting toolbar or reapply the corresponding style.
Do not use these styles when only key terms or phrases at the beginning of a subclause need to be emphasized as
is often the case for lists of apparatus and of reagents and/or materials; use instead the style “Subclause without
title” (see 5.2.2.3).
Hitting return after you have entered a subclause with a title will put the cursor in a new paragraph in the style
‘‘Normal” (see 5.2.3).
The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of subdivision
respectively.
Although the stylesheet terminology concerning subclauses conforms with that used in the ISO/IEC Directives,
Part 2, 2001[1], 5.2.3 and 5.2.6, the style names have been attributed to facilitate their autonumbering rather than to
reflect this terminology. Table 2 shows the style names and examples of the numbering produced both in the body
of the standard and in the annexes.
Table 2 — Clauses and subclauses: their style names and examples of numbering
Body of standard
Style name

Example of
numbering
(in this case
for Clause 4)

Style name

Example of
numbering
(in this case
for Clause A.2)

Heading 1

4

a2

A.2

level 1

Heading 2

4.1

a3

A.2.1

level 2

Heading 3

4.1.1

a4

A.2.1.1

level 3

Heading 4

4.1.1.1

a5

A.2.1.1.1

level 4

Heading 5

4.1.1.1.1

a6

A.2.1.1.1.1

level 5

Heading 6

4.1.1.1.1.1

—a

—a

level 1

p2

4.1

p3

A.2.1

level 2

p3

4.1.1

p4

A.2.1.1

level 3

p4

4.1.1.1

p5

A.2.1.1.1

level 4

p5

4.1.1.1.1

p6

A.2.1.1.1.1

level 5

p6

4.1.1.1.1.1

—a

—a

Terminology in ISO/IEC Directives,
Part 2[1]

Clause

Subclause with title

Subclause without title

Annexes

a

The stylesheet is limited to four levels of subdivision of subclauses in annexes although the ISO/IEC Directives, Part 2[1], allows a fifth
level.
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5.2.2.3

Subclauses without titles

5.2.2.3.1

Styles

Names: p2 to p6
Automatic numbering: no
5.2.2.3.2

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select ‘‘Subclause without title” from the menu; type the number of the subclause and
click “OK”.
5.2.2.3.3

Remarks

If text styled “p2” to “p6” is subsequently restyled, the number and the tabulation will remain and will need to be
deleted manually.
Hitting return after you have entered a subclause without a title will put the cursor in a new paragraph in the style
“Normal”.
Although the stylesheet terminology concerning subclauses conforms with that used in the ISO/IEC Directives,
Part 2, 2001[1], 5.2.3 and 5.2.6, the style names have been attributed to facilitate their autonumbering rather than to
reflect this terminology. Table 2 shows the style names and examples of the numbering produced both in the body
of the standard and in the annexes.
5.2.3
5.2.3.1

Paragraphs
Drafting rules

A paragraph is an unnumbered subdivision of a clause or subclause.
“Hanging paragraphs” (see ISO/IEC Directives, Part 2, 2001[1], 5.2.4) shall be avoided since reference to them is
ambiguous.
5.2.3.2

Style

Style name: Normal
Automatic numbering: no
5.2.3.3

Applying the style

Select “Normal” from the Style drop-down list or use the keyboard shortcut Ctrl+Shift+N.
5.2.3.4

Remarks

All the styles in the stylesheet have been based on the “Normal” style.
IMPORTANT — Most of the elements that can be inserted via the “Framework” dialogue box of the
“Framework element” menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)]
require that the cursor be positioned in a “Normal” style paragraph. Therefore it is useful to memorize the
keyboard shortcut command given in 5.2.3.3.
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5.2.4

Lists

5.2.4.1

Drafting rules

Lists may be introduced by a sentence, a complete grammatical proposition followed by a colon, or by the first part
of a proposition (without a colon), completed by the items in the list. In the latter case, to aid comprehension, it may
be preferable not to continue a sentence after the end of the list.
Each item in a list shall be preceded by a dash (i.e. an unordered list) (note that although the ISO/IEC Directives,
Part 2[1], also allows list items to be preceded by a bullet only the dash option has been implemented in the
stylesheet) or, if necessary for identification, by a lower case letter followed by a parenthesis (i.e. an ordered list). If
it is necessary to subdivide further an item in the latter type of list, Arabic numerals followed by a parenthesis shall
be used.
Key terms or phrases may be composed in distinctive type to call attention to the subject matter dealt with in the
various list items. Such terms or phrases shall not be listed in the table of contents; if it is necessary that they be
included in the table of contents, they shall not be presented as list items but as subclause titles.
5.2.4.2
5.2.4.2.1

Unordered lists
Styles

Names: List Continue to List Continue 4
Automatic numbering: yes
5.2.4.2.2

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “List” from the menu; select the “Unordered” tab and click on the list item level
desired.
5.2.4.2.3

Remarks

For unordered lists, the text of each list item is, by default, automatically preceded by a dash. Each level is inset
with respect to the previous one.
After having typed the text in the unordered list item, press return to put the cursor in the next list item at the same
level.
The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of subdivision
respectively.
If a list item contains more than one paragraph, only the first paragraph should be preceded by a dash. To effect
this, create the complete series of list items, each preceded by a dash. Then, one by one (since by default, only the
dash of the first paragraph of a selection will be eliminated) select the list items which are not to be preceded by a
dash and click on the “Elements” button, on “List” in the menu, and then on the “Skip numbering” button. If it is
necessary to reinsert a dash, select the paragraph concerned and proceed as indicated in 5.2.4.2.2.
5.2.4.3
5.2.4.3.1

Ordered lists
Style

Names: List Number to List Number 4
Automatic numbering: yes
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5.2.4.3.2

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “List” from the menu; select the “Ordered” tab and click on the list item level
desired.
5.2.4.3.3

Remarks

In an ordered list, the list item identifiers are generated automatically in the following sequence:
level 1:
level 2:
level 3:
level 4:

a), b), c), etc.
1), 2), 3), etc.
i), ii), iii), etc.
I), II), III), etc.

with each level being inset with respect to the previous one.
After having typed the text in the ordered list item, press return to put the cursor in the next list item at the same
level.
The “Increase Indent” and “Decrease Indent” buttons on the toolbar apply a higher or a lower level of subdivision
respectively.
By default, the numbering at level 1 is continuous from the beginning to the end of the document. To restart the
numbering, click the check box “Restart numbering” before clicking on the button corresponding to the desired level
of the “Lists” dialogue box.
If a list item contains more than one paragraph, only the first paragraph should have an identifier (i.e. a letter or
number followed by a parenthesis). To effect this, create the complete series of ordered list items. Then, one by
one (since by default, only the list item identifier of the first paragraph of a selection will be eliminated), select the
list items which are not to be preceded by an identifier and click on the “Elements” button, on “List” in the menu,
and then on the “Skip numbering” button. If it is necessary to restart the numbering, select the paragraph
concerned and proceed as indicated in 5.2.4.3.2.
If the list item identifier (i.e. the letter or number followed by a parenthesis) does not have the correct typographic
format (i.e. 10 pt, upright, lightface), select the paragraph mark at the end of list item text and apply the correct
format using the formatting buttons, or reapply the appropriate style to it.
5.2.5
5.2.5.1

Annexes
Drafting rules

Annexes shall appear in the order in which they are cited in the text. Each annex shall be designated by a heading
comprising the word “Annex” followed by a capital letter designating its serial order, beginning with “A”, e.g.
“Annex A”. The annex heading shall be followed by the indication “(normative)” or “(informative)”, and by the title,
each on a separate line. Numbers given to the clauses, subclauses, tables, figures and mathematical formulae of
an annex shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start
afresh with each annex. A single annex shall be designated “Annex A”.
Normative annexes give provisions additional to those in the body of the document. Their presence is optional. An
annex’s normative status (as opposed to informative) shall be made clear by the way in which it is referred to in the
text, by an indication in the table of contents and under the heading of the annex.
Informative annexes give additional information intended to assist the understanding or use of the document. They
shall not contain requirements, except as described in the next paragraph. Their presence is optional. An annex’s
informative status (as opposed to normative) shall be made clear by the way in which it is referred to in the text, by
an indication in the table of contents and under the heading of the annex.
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Informative annexes may contain optional requirements. For example, a test method that is optional may contain
requirements but there is no need to comply with these requirements to claim compliance with the document.
5.2.5.2

Style

Name: ANNEX
Automatic numbering: yes
5.2.5.3

Applying the style

Position the cursor in an empty “Normal” style paragraph at the location where you want to introduce the annex,
click on the “Elements” button of the STD toolbar, and select “Framework element”. In the “Framework” dialogue
box select the type of annex (normative or informative) that you want to insert and then click on the “Add” button;
type the title in the “Informative [Normative] annex / Title” dialogue box and click on the “OK” button. It is possible to
insert several annexes before closing the “Framework” dialogue box. (See 4.4.)
5.2.5.4

Remarks

When an annex is inserted as indicated in 5.2.5.3, the template automatically inserts a page break before the
annex heading so that each annex starts on a new page.
This style applies only to the heading, status and title of an annex. Clauses in annexes are styled “a2” (see 5.2.1)
and subclauses with titles in annexes are styled “a3” to “a6” (see 5.2.2.2); other elements are styled in the same
way as in the body of a standard.

5.3

Inserting elements

5.3.1
5.3.1.1

Cover sheet
General

The cover sheet gives the set of information applicable to the document (reference to the working document,
organization responsible for the secretariat, reference to the responsible TC, SC and/or WG, reference and title of
the document, indication of the document type and sub-type, if applicable, the stage and document language, the
name of the file and a reference to the template used).
The title pages of enquiry drafts, final drafts and final publications are prepared in a standard format by the Central
Secretariat of ISO.
5.3.1.2

Style

Name: zzCover
Automatic numbering: no
5.3.1.3

Applying the style

Element inserted by the template.
5.3.1.4

Remarks

The entire cover sheet is in the “zzCover” style.
The cover sheet is generated from the data entered in the STD manager. Therefore, changes to the cover sheet
shall be made only by changing the data in the STD manager: click on the “Doc.Info” button (see 4.2) and add or
change the data in the relevant dialogue box.
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Do not delete the name of the file and the reference to the template at the bottom of the cover sheet.
5.3.2

Document title

5.3.2.1

Drafting rules

The wording of the title shall be established with the greatest care; while being as concise as possible, it shall
indicate, without ambiguity, the subject matter of the document in such a way as to distinguish it from that of other
documents, without going into unnecessary detail. Any necessary additional particulars shall be given in the scope.
The title shall be composed of separate elements, each as short as possible, proceeding from the general to the
particular. In general, not more than the following three elements shall be used:
a) an introductory element (optional) indicating the general field to which the document belongs (this can often be
based on the title of the committee which prepared the document);
b) a main element (obligatory) indicating the principal subject treated within that general field;
c) a complementary element (optional) indicating the particular aspect of the principal subject or giving details that
distinguish the document from other documents, or other parts of the same document.
The complementary element is necessary if the document covers only one or a few aspects of the subject indicated
in the main element.
In the case of a document published as a series of parts, the complementary element serves to distinguish and
identify the parts [the introductory element (if present) and the main element remaining the same for each part].
EXAMPLE
IEC 60747-1 Semiconductor devices — Discrete devices — Part 1: General
IEC 60747-2 Semiconductor devices — Discrete devices — Part 2: Rectifier diodes

If the document covers several (but not all) aspects of the subject indicated in the main element, the aspects
covered shall be referred to by a general term such as “specification” or “mechanical requirements and test
methods” rather than be enumerated one by one.
The complementary element shall be omitted if the document both


covers all essential aspects of the subject indicated in the main element, and



is (and is intended to remain) the only document relating to this subject.

Detailed rules for the drafting of titles are given in the ISO/IEC Directives, Part 2, 2001[1], Annex D.
5.3.2.2

Styles

Names: zzSTDTitle (document title on page 1 of the document)
zzCover (cover sheet)
Automatic numbering: no
5.3.2.3

Applying the style

Element inserted by the template.
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5.3.2.4

Remarks

The title is generated from the data entered in the STD manager. Therefore, changes to the title shall be made only
by changing the data in the STD manager; click on the “Doc.Info” button (see 4.2) and add or change the data in
the relevant dialogue box.
See the Notes in 4.2.2.
5.3.3

Table of contents

5.3.3.1

Drafting rules

The table of contents is an optional preliminary element, but is necessary if it makes the document easier to
consult. The table of contents shall be entitled “Contents” and shall list clauses and, if appropriate, subclauses with
titles, annexes together with their status in parentheses, the bibliography, indexes, figures and tables. The order
shall be as follows: clauses and subclauses with titles; annexes (including clauses and subclauses with titles if
appropriate); the bibliography; indexes; figures; tables. All the elements listed shall be cited with their full titles.
Terms in the “Terms and definitions” clause shall not be listed in the table of contents.
5.3.3.2
5.3.3.2.1

“Contents” title
Style

Name: zzContents
Automatic numbering: no
5.3.3.2.2

Applying the style

Element inserted by the template.
5.3.3.2.3

Remarks

This style applies only to the title of the table of contents. The entries in the table of contents are styled “TOC” (see
5.3.3.3).
When a new document is created, the table of contents is generated automatically in the document skeleton. It
contains the title “Contents” and the table of contents (see 5.3.3.3).
If necessary, the title “Contents”, together with the table of contents (see 5.3.3.3), can be reinserted as follows.
Position the cursor in an empty paragraph in “Normal” style between the cover sheet and the foreword, select
“Contents” in the “Framework element” menu [opened by clicking on the “Elements” button of the STD toolbar (see
4.4)].
5.3.3.3
5.3.3.3.1

Table of contents
Styles

Names: TOC 1 to TOC 6, and TOC 9
Automatic numbering: no
5.3.3.3.2

Applying the style

Element inserted by the template.
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5.3.3.3.3

Remarks

The table of contents is generated automatically. To update it, place the cursor anywhere in the table of contents
and press F9.
It is not necessary to update the table of contents after inserting each element which needs to appear in the table
of contents; you may wait if you prefer and press F9 once before you print or close the file. However, if the page
numbers in the table of contents are replaced by the error message “Error! Bookmark not defined!”, update it as
described above.
Do not forget to update the table of contents when you have finished drafting your document and before you print it.
Beware that the table of contents may not be up to date in drafts you receive.
Each of the entries, other than foreword and introduction (if present), consists of the clause or subclause number, a
tabulation, the clause or subclause title and a tabulation followed by the corresponding page number (where this is
known). The clause and subclause titles are entered at the same level in the table of contents as their heading
style level [for example, clause titles (“Heading 1” style) are entered as a “TOC 1” style, subclause titles at level 1
(“Heading 2” style) are entered as “TOC 2” style, etc.]. The “TOC 9” style is reserved for unnumbered titles
(foreword, introduction, bibliography and index).
By default, only headers up to level 3 will appear. If you wish to change this option, display the field codes (in the
“Tools” menu, select the “Options...” command, choose the “View” tab and check the “Field codes” box) and
replace «\o “1-3”» by «\o “1-4”» for 4 levels or «\o “1-2”» for two levels, etc. Do not change the other codes. If you
prefer, you can also change the options by using the “Index and Tables...” command in the “Insert” menu (select
the option “From template” and press the “Options” button).
To insert a table of figures, type the title “Figures” at the bottom of the table of contents and apply the “Special”
style. Format it to obtain the desired presentation. Place the cursor in a new “Normal” style paragraph under the
title. In the “Insert” menu, choose the “Index and Tables...” command, then click on the “Table of Figures” tab.
Choose the option “Figure” under “Caption label”. Under “Formats” choose the “From template” option. Press the
“Options” button and in the “Table of Figures Options” dialogue box, select the “Style” option and “Figure title” from
the list. Click twice on the “OK” button. Answer “No” to the question “Do you want to replace the selected table of
figures”.
To insert a table of tables, type the title “Tables” at the bottom of the table of contents and apply the “Special” style.
Format it to obtain the desired presentation. Place the cursor in a new “Normal” style paragraph under the title. In
the “Insert” menu, choose the “Index and Tables...” command, then click on the “Table of Figures” tab. Choose the
option “Table” under “Caption label”. Under “Formats” choose the “From template” option. Press the “Options”
button and in the “Table of Figures Options” dialogue box, select the “Style” option and “Table title” from the list.
Click twice on the “OK” button. Answer “No” to the question “Do you want to replace the selected table of figures”.
If necessary, the table of contents can be reinserted, at the same time as the “Contents” title (see 5.3.3.2), as
follows. Position the cursor in an empty paragraph in “Normal” style between the cover sheet and the foreword,
select “Contents” in the “Framework element” menu [opened by clicking on the “Elements” button of the STD
toolbar (see 4.4)].
5.3.4

Foreword

5.3.4.1

Drafting rules

The foreword shall appear in each document. It shall not contain requirements, recommendations, figures or tables.
5.3.4.2
5.3.4.2.1

“Foreword” title
Style

Name: zzForeword
Automatic numbering: no
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5.3.4.2.2

Applying the style

Element inserted by the template.
5.3.4.2.3

Remarks

This style applies only to the title of the foreword. The text given in the foreword is in the style “Foreword” (see
5.3.4.3).
The foreword is not numbered.
The foreword is automatically generated in the document skeleton when a new document is created. It consists of
the “Foreword” title followed by the foreword text (5.3.4.3).
5.3.4.3

Foreword text

5.3.4.3.1

Style

Name: Foreword
Automatic numbering: no
5.3.4.3.2

Applying the style

Element inserted by the template.
5.3.4.3.3

Remarks

The text of the foreword is automatically generated in the document skeleton from the data entered in the STD
manager. Therefore, changes to the text appearing in blue (see 4.1.4.2) shall be made only by changing the data in
the STD manager: click on the “Doc.Info” button (see 4.2) and add or change the data in the relevant dialogue box.
Text appearing in red (see 4.1.4.3) should be either completed or deleted. Complete the text with the following
information, as necessary:


an indication of any other international organization that has contributed to the preparation of the document;



a statement that the document cancels and replaces other documents in whole or in part (see the procedure in
4.2.3);



a statement of significant technical changes from any previous edition of the document;



the relationship of the document to other documents.

The foreword text is automatically regenerated every time the STD manager is run. Therefore, to avoid having to
repeat the modifications to the text in red, change the modified foreword text (i.e. that in red) to the “Special” style.
When changes are made to data in the STD manager, the modified foreword text changed to the “Special” style will
remain either before or after the automatically generated foreword text, depending on where it was initially, and the
new automatically generated text can simply be deleted.
5.3.5
5.3.5.1

Introduction
Drafting rules

The introduction is an optional preliminary element used, if required, to give specific information or commentary
about the technical content of the document, and about the reasons prompting its preparation. It shall not contain
requirements.
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The introduction shall not be numbered unless there is a need to create numbered subdivisions. In this case, it
shall be numbered 0, with subclauses being numbered 0.1, 0.2, etc. Any numbered figure, table, displayed formula
or footnote shall be numbered normally beginning with 1.
5.3.5.2

“Introduction” title

5.3.5.2.1

Style

Name: Introduction
Automatic numbering: no
5.3.5.2.2

Applying the style

Element inserted by the template.
5.3.5.2.3

Remarks

This style applies only to the title of the introduction. The text given in the introduction is in the style “Normal”
(see 5.2.3).
The title “Introduction” is automatically generated in the document skeleton when a new document is created. If
necessary, it can be reinserted as follows. Position the cursor in an empty paragraph in “Normal” style between the
the foreword and the section break preceding the title on page 1, select “Introduction” in the “Framework element”
menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)].
5.3.6
5.3.6.1

Basic clauses
“Scope” clause

The “Scope” clause shall appear at the beginning of each document and define without ambiguity the subject of the
document and the aspects covered, thereby indicating the limits of applicability of the document or particular parts
of it. It shall not contain requirements.
In documents that are subdivided into parts, the scope of each part shall define the subject of that part of the
document only.
The scope shall be succinct so that it can be used as a summary for bibliographic purposes.
It shall be worded as a series of statements of fact. Forms of expression such as “This International Standard
specifies [establishes] [gives guidelines for] [defines terms] …” shall be used.
Statements of applicability of the document shall be introduced by the wording such as “This International Standard
is applicable to …”. The wording shall be altered as a function of the document type concerned, i.e. International
Standard, Technical Specification, Publicly Available Specification, Technical Report or Guide.
The title “Scope” (in a “Heading 1” style) is automatically generated in the document skeleton when a new
document is created. If necessary, it can be reinserted using the “Framework element” menu [opened by clicking
on the “Elements” button of the STD toolbar (see 4.4)].
5.3.6.2

“Conformance” clause

The “Conformance” clause is only required in some standards in the Information technology field. Requirements
concerning the “Conformance” clause are not covered by the ISO/IEC Directives, Part 2, 2001[1], but by
ISO/IEC TR 10000-1[4].
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The title “Conformance” (in a “Heading 1” style) can be inserted using the “Framework element” menu [opened by
clicking on the “Elements” button of the STD toolbar (see 4.4)].
5.3.6.3

“Normative references” clause

The “Normative references” clause is an optional element that gives a list of the referenced documents cited in the
document in such a way as to make them indispensable for the application of the document.
The title “Normative references” (in a “Heading 1” style) together with the introductory text (in “Normal” style) for the
list of normative references as well as two normative reference examples (in “RefNorm” style) can be inserted using
the “Framework element” menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)].
The list of normative references is introduced by a boilerplate text which is automatically inserted by the template.
In principle, the referenced documents shall be documents published by ISO and/or IEC. Documents published by
other bodies may be referred to in a normative manner provided that
a) the referenced document is recognized by the ISO and/or IEC committee concerned as having wide
acceptance and authoritative status as well as being publicly available,
b) the ISO and/or IEC committee concerned has obtained the agreement of the authors or publishers (where
known) of the referenced document to its inclusion and to its being made available as required — the authors
or publishers will be expected to make available such documents on request,
c) the authors or publishers (where known) have also agreed to inform the ISO and/or IEC committee concerned
of their intention to revise the referenced document and of the points the revision will concern, and
d) the ISO and/or IEC committee concerned undertakes to review the situation in the light of any changes in the
referenced document.
The list shall not include the following:


referenced documents which are not publicly available;



referenced documents which are only cited in an informative manner;



referenced documents which have merely served as bibliographic or background material in the preparation of
the document.

Such referenced documents may be listed in a bibliography (see 5.3.15).
Normative references shall be either dated or undated.
Dated references are references to
a) a specific edition, indicated by the year of publication, or
b) a specific enquiry or final draft, indicated by a dash.
Subsequent amendments to, or revisions of, dated references will need to be incorporated by amendment of the
document referring to them.
NOTE

In this context a part is regarded as a separate document.

References to specific divisions or subdivisions, tables and figures of another document shall always be dated.
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Undated references may be made only to a complete document or a part thereof and only in the following cases:
a) if it is accepted that it will be possible to use all future changes of the referenced document for the purposes of
the referring document;
b) for informative references.
Undated references shall be understood to include all amendments to and revisions of the referenced document.
For dated references, each shall be given with its year of publication, or, in the case of enquiry or final drafts, with a
dash together with a footnote “To be published.”, and full title. The year of publication or dash shall not be given for
undated references. When an undated reference is to all parts of a document, the publication number shall be
followed by the indication “(all parts)” and the general title of the series of parts (i.e. the introductory and main
elements, see ISO/IEC Directives, Part 2, 2001[1], Annex D).
EXAMPLE
ISO 31 (all parts), Quantities and units
ISO 10241:1992, International terminology standards — Preparation and layout

5.3.6.4

“Terms and definitions” clause

5.3.6.4.1

General

The “Terms and definitions” clause is an optional element giving definitions necessary for the understanding of
certain terms used in the document.
The title “Terms and definitions” (in a “Heading 1” style) together with the introductory text (in “Normal” style) for the
list of terms and definitions as well as two examples of terms and definitions (in “TermNum”, “Term(s)” and
“Definition” styles) can be inserted using the “Framework element” menu [opened by clicking on the “Elements”
button of the STD toolbar (see 4.4)].
The list of terms and definitions is introduced by a boilerplate text which is automatically inserted by the template.
Text appearing in red (see 4.1.4.3) should be either completed or deleted.
Rules for the drafting and presentation of terms and definitions are given in the ISO/IEC Directives, Part 2, 2001[1],
Annex C, and in ISO 10241[5].
The series of styles for terms and definitions is given in 5.3.6.4.2 to 5.3.6.4.4.
Although the presentation of a term and its reference number resembles that of a subclause, they do not constitute
a subclause and are not subject to the same rules (it is permissible, for example, to have a single term). Terms
shall not be listed in the table of contents. Subclauses with titles may be present in the “Terms and definitions”
clause; if so, the style “Subclause with title” (see 5.2.2.2) may be used but only if the subdivision is homogeneous
and if no term is at the same level as a subclause with a title.
5.3.6.4.2
5.3.6.4.2.1

Term reference number
Style

Name: TermNum
Automatic numbering: no
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5.3.6.4.2.2

Applying the style

Three alternative methods can be used.
a)

Adapt the examples inserted using the “Framework element” menu [opened by clicking on the “Elements”
button of the STD toolbar (see 4.4)].

b)

Click on the “Elements” button of the STD toolbar, select “Definition”, type in the reference number of the term
and click on the “OK” button.

c)

Position the cursor in an empty paragraph in “Normal” style, click on the right-hand button of the mouse to
display the contextual menu, select “Definition”, type in the reference number of the term and click on the “OK”
button.

5.3.6.4.2.3

Remarks

Hitting return after having entered a term reference number will put the cursor in a new paragraph in the style
‘‘Term(s)”.
All terms shall be numbered. If only a single term is given, it shall be numbered.
5.3.6.4.3

Term

5.3.6.4.3.1

Style

Name: Term(s)
Automatic numbering: no
5.3.6.4.3.2

Applying the style

Two alternative methods can be used.
a)

Adapt the examples inserted using the “Framework element” menu [opened by clicking on the “Elements”
button of the STD toolbar (see 4.4)].

b)

Hit return after having entered the term reference number.

5.3.6.4.3.3

Remarks

The preferred term shall be placed on a new line, after its reference number, starting with a lower case letter except
for any capital letters required by the normal written form in running text.
Hitting return after you have entered a term will put the cursor in a new paragraph in the style ‘‘Definition”. If you
need to insert one or more synonyms, hit return and then select the ‘‘Term(s)” style from the Style drop-down list
before typing in the synonym (see the following example).
EXAMPLE
3.2
term
synonym
text of the definition

Use the style ‘‘Term(s)” for terms in a “Terms and definitions” clause or in a vocabulary.
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5.3.6.4.4

Definition

5.3.6.4.4.1

Style

Name: Definition
Automatic numbering: no
5.3.6.4.4.2

Applying the style

Two alternative methods can be used.
a)

Adapt the examples inserted using the “Framework element” menu [opened by clicking on the “Elements”
button of the STD toolbar (see 4.4)].

b)

Hit return after having entered the term.

5.3.6.4.4.3

Remarks

The definition shall be placed on a new line, starting with a lower case letter, except for any capital letters required
by the normal written form in running text, and shall not be followed by a full-stop.
Hitting return after you have entered a definition will put the cursor in a new paragraph in the style “Normal”.
5.3.6.5

“Symbols and abbreviated terms” clause

The “Symbols and abbreviated terms” clause is an optional element giving a list of the symbols and abbreviated
terms necessary for the understanding of the document.
The title “Symbols and abbreviated terms” (in a “Heading 1” style) can be inserted using the “Framework element”
menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)].
Unless there is a need to list symbols in a specific order to reflect technical criteria, all symbols should be listed in
alphabetical order in the following sequence:


upper case Latin letter followed by lower case Latin letter (A, a, B, b, etc.);



letters without indices preceding letters with indices, and with letter indices preceding numerical ones (B, b, C,
Cm, C2, c, d, dext, dint, d1, etc.);



Greek letters following Latin letters (Z, z, Α, α, Β, β, …, Λ, λ, etc.);



any other special symbols.

The template has a function which allows the insertion of symbols without using the equation editor (see 5.3.14).
For convenience, this element may be combined with the “Terms and definitions” clause in order to bring together
terms and their definitions (see 5.3.6.4), symbols, abbreviated terms and perhaps units under an appropriate
composite title, for example “Terms, definitions, symbols, units and abbreviated terms”.
5.3.6.6

“Requirements” clause

The “Requirements” clause is an optional element.
The title “Requirements” (in a “Heading 1” style) can be inserted using the “Framework element” menu [opened by
clicking on the “Elements” button of the STD toolbar (see 4.4)].
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If present, it shall contain the following:
a) all characteristics relevant to the aspects of the products, processes or services covered by the document,
either explicitly or by reference;
b) the required limiting values of quantifiable characteristics;
c) for each requirement, either a reference to the test method for determining or verifying the values of the
characteristic, or the test method itself (see 5.3.6.8).
A clear distinction shall be made between requirements, statements and recommendations.
Contractual requirements (concerning claims, guarantees, covering of expenses, etc.) and legal or statutory
requirements shall not be included.
In some product standards, it may be necessary to specify that the product shall be accompanied by warning
notices (see 5.3.17.3 for the method of insertion) or by instructions to the installer or user, and to specify their
nature. On the other hand, requirements concerning installation or use as such shall be included in a separate part
or a separate document, since they are not requirements applicable to the product itself.
Documents listing characteristics for which suppliers are required to state values not specified by the document
itself shall specify how such values are to be measured and stated.
5.3.6.7

“Sampling” clause

The “Sampling” clause is an optional element specifying the conditions and methods of sampling, as well as the
method for the preservation of the samples.
The title “Sampling” (in a “Heading 1” style) can be inserted using the “Framework element” menu [opened by
clicking on the “Elements” button of the STD toolbar (see 4.4)].
This element may appear at the beginning of the element “Test methods” (see 5.3.6.8).
5.3.6.8

“Test methods” clause

The “Test methods” clause is an optional element giving all the provisions concerning the procedure for
determining the values of characteristics or checking conformity to stated requirements, and for ensuring the
reproducibility of the results. If appropriate, tests shall be identified to indicate whether they are type tests, routine
tests, sampling tests and so on. In addition, the document shall specify the sequence of testing if the sequence can
influence the results.
The title “Test methods” (in a “Heading 1” style) can be inserted using the “Framework element” menu [opened by
clicking on the “Elements” button of the STD toolbar (see 4.4)].
Test methods may be subdivided in the following order (where appropriate):
a) principle;
b) reagents and/or materials;
c) apparatus;
d) preparation and preservation of test samples and test pieces;
e) procedure;
f)

expression of results, including method of calculation and precision of the test method, and, in ISO, the
measurement uncertainty;

g) test report.
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Test methods may be presented as separate clauses, or be incorporated in the requirements (see 5.3.6.6), or be
presented as annexes or as separate parts. A test method shall be prepared as a separate document if it is likely to
be referred to in a number of other documents.
When drafting test methods, account shall be taken of documents for general test methods and of related tests for
similar characteristics in other documents. Non-destructive test methods shall be chosen whenever they can
replace, within the same level of confidence, destructive test methods.
For the drafting of methods of chemical analysis, see ISO 78-2[6]. Much of ISO 78-2 is also applicable to test
methods for products other than chemical products.
Additional rules are given in the ISO/IEC Directives, Part 2, 2001[1], 6.3.5.
5.3.6.9

“Classification, designation and coding” clause

The “Classification, designation and coding” clause is an optional element which may establish a system of
classification, designation (see ISO/IEC Directives, Part 2, 2001[1], Annex F) and/or coding of products, processes
or services that conform to stated requirements.
The title “Classification and designation” (in a “Heading 1” style) can be inserted using the “Framework element”
menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)].
For convenience, this element may be combined with the element “Requirements” (see 5.3.6.6).
Additional rules are given in the ISO/IEC Directives, Part 2, 2001[1], 6.3.6.
To insert a designation, position the cursor in an empty paragraph in “Normal” style, then either click on the
“Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display the contextual menu,
and select “Designation” from the menu (see 5.3.17.3).
5.3.6.10

“Marking, labelling and packaging” clause

The “Marking, labelling and packaging” clause shall be included wherever relevant, particularly for product
standards concerning consumer goods. If necessary, the means of marking shall also be specified or
recommended.
Additional rules are given in the ISO/IEC Directives, Part 2, 2001[1], 6.3.7.
The title “Marking, labelling and packaging” (in a “Heading 1” style) can be inserted using the “Framework element”
menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)].
The clauses “Classification and designation” (see 5.3.6.9) and “Marking, labelling and packaging” may be
supplemented by an informative annex giving an example of ordering information.
5.3.7

Notes integrated in the text

5.3.7.1

Drafting rules

Notes integrated in the text of a document shall only be used for giving additional information intended to assist the
understanding or use of the document. These elements shall not contain requirements or any information
considered indispensable for the use of the document.
EXAMPLE
The following note is incorrectly drafted as a note since it contains a requirement (highlighted in italics and
explained in parentheses after the example) and clearly does not constitute “additional information”.
NOTE
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Notes should preferably be placed at the end of the clause or subclause, or after the paragraph, to which they
refer.
A single note in a clause or subclause shall be preceded by “NOTE”, placed at the beginning of the first line of the
text of the note. When several notes occur within the same clause or subclause, they shall be designated
“NOTE 1”, “NOTE 2”, “NOTE 3”, etc.
5.3.7.2

Style

Name: Note
Automatic numbering: no
5.3.7.3

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Note” from the menu.
5.3.7.4

Remarks

When a note is inserted using either the “Elements” button or the contextual menu, the text “NOTE” is generated
automatically followed by a tabulation. If the note is to be numbered (see 5.3.7.1), insert the number, preceded by a
nonbreaking space (combination of keys Ctrl+Shift+space bar), before the tabulation.
In this stylesheet, notes are in a smaller font size than that of the “Normal” style so that the extent of the note can
be determined easily.
Hitting return after you have entered a note will put the cursor in a new paragraph in the style “Normal”.
5.3.8
5.3.8.1

Examples integrated in the text
Drafting rules

Examples integrated in the text of a document shall only be used for giving additional information intended to assist
the understanding or use of the document. These elements shall not contain requirements or any information
considered indispensable for the use of the document.
Examples should preferably be placed at the end of the clause or subclause, or after the paragraph, to which they
refer.
A single example in a clause or subclause shall be preceded by “EXAMPLE”, placed at the beginning of the first
line of the text of the example. When several examples occur within the same clause or subclause, they shall be
designated “EXAMPLE 1”, “EXAMPLE 2”, “EXAMPLE 3”, etc.
5.3.8.2

Style

Name: Example
Automatic numbering: no
5.3.8.3

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Example” from the menu.
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5.3.8.4

Remarks

When an example is inserted using either the “Elements” button or the contextual menu, the text “EXAMPLE” is
generated automatically followed by a tabulation. If the example is to be numbered (see 5.3.8.1), insert the number,
preceded by a nonbreaking space (combination of keys Ctrl+Shift+space bar), before the tabulation.
In this stylesheet, examples are in a smaller font size than that of the “Normal” style so that the extent of the
example can be determined easily.
Hitting return after you have entered an example will put the cursor in a new paragraph in the style “Normal”.
5.3.9

Footnotes to the text

5.3.9.1

Drafting rules

Footnotes to the text give additional information; their use shall be kept to a minimum. A footnote shall not contain
requirements or any information considered indispensable for the use of the document.
Footnotes to the text shall be placed at the foot of the relevant page and be separated from the text by a short thin
horizontal line on the left of the page.
Footnotes to the text shall normally be distinguished by Arabic numerals, beginning with 1, followed by one
parenthesis and forming a continuous numerical sequence throughout the document: 1), 2), 3), etc. The footnotes
shall be referred to in the text by inserting the same numerals, as superscripts, after the word or sentence in
1) 2) 3)
question:
etc.
5.3.9.2

Style

Name: Footnote Reference (for the reference); Footnote Text (for the text of the footnote)
Automatic numbering: yes
5.3.9.3

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Footnote” from the menu.
5.3.9.4

Remarks

Position the cursor at the place where the footnote reference is to be inserted, then apply the style as described in
5.3.9.3, and type in the footnote text in the “Footnotes” dialogue box.
To make multiple references to the same footnote, ensure that the footnote to be referenced has been inserted as
described in 5.3.9.3. In order to make further references to the same footnote, position the cursor at the place
where the footnote reference is to be inserted, then choose the “Insert” “Cross-reference” command. In the “Crossreference” dialogue box, select the “Footnote” option under “Reference type” and the “Footnote number” option
under “Insert reference to”. In the list entitled “For which footnote” select the footnote which you want to reference.
Click on the “Elements” button then the “Close” button. In the document, with the cursor positioned after the
inserted footnote reference, add a closing parenthesis. Select both the footnote reference and the closing
parenthesis, and select the “Footnote Reference” style from the Style drop-down list.
5.3.10 Figures
5.3.10.1

Drafting rules

Figures should be used when they are the most efficient means of presenting information in an easily
comprehensible form. It shall be possible to refer to each figure explicitly within the text.
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Figures shall be in the form of line drawings. Photographs may be used only if it is not possible to convert them into
line drawings. Photocopies are not usable.
In general, the use of subfigures should be avoided whenever possible since it complicates document layout and
management. Subfigures shall only be used when it is essential for comprehension of the subject matter. Only one
level of subdivision of a figure is permitted. Additional rules concerning subfigures are given in the
ISO/IEC Directives, Part 2, 2001[1], 6.6.5.11.
5.3.10.2

Drawings

5.3.10.2.1 Drafting rules
Letter symbols used in figures to represent general cases of angular or linear quantities shall be in accordance with
ISO 31-1[7], subscripts being used where necessary to distinguish between different applications of a given symbol.
For a series of symbols indicating various lengths on a drawing use l1, l2, l3, etc. and not, for instance, A, B, C, etc.
or a, b, c, etc.
Lettering on drawings shall be in accordance with ISO 3098-2[8]. Inclined (italic) letters shall be used for


symbols for quantities,



subscripts representing symbols for quantities, and



symbols representing numbers.

The vertical (upright) style shall be used for all other lettering.
In artwork, textual descriptions shall be replaced by item references (see ISO 6433[9]) the meaning of which are
explained in a key, or figure footnote (see 5.3.10.4) depending on their content. In graphs, labelling on the axes
shall not be replaced by item references to avoid any possible confusion between the number representing an item
reference and a number representing a value on the axis. Labelling of curves, lines, etc. on the graph shall be
replaced by item references, however many curves, lines, etc. there are.
Technical drawings shall be prepared in accordance with relevant ISO standards (see the ISO/IEC Directives,
Part 2, 2001[1], A.8). The additional rules specified in the ITSIG Guide, 3rd edition[19], Annex E, shall be followed.
Graphical symbols for use on equipment shall be in accordance with IEC 60417[10] and ISO 7000[11].
Diagrams, such as circuit diagrams and connection diagrams, for example for test circuits, shall be prepared in
accordance with IEC 61082[12]. Graphical symbols used in schematic diagrams shall be in accordance with
IEC 60617[13] and ISO 14617[14]. Reference designations and signal designations shall be in accordance with
IEC 61346[15] and IEC 61175[16] respectively.
5.3.10.2.2 Style
Name: Normal
Automatic numbering: no
5.3.10.2.3 Applying the style
Select the “Normal” style from the Style drop-down list or use the keyboard shortcut Ctrl+Shift+N.
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5.3.10.2.4 Remarks
Drawings and any statements concerning the dimensions used shall be placed in “Normal” style paragraphs (see
5.2.3). Use the formatting commands of your word processor to align the paragraphs to the desired position (for
example, for the statement concerning dimensions, use the formatting commands to align it to the right-hand
margin and to reduce the font size by one point). See the example in 5.3.10.5.4.
To insert a figure, position the cursor in an empty paragraph in “Normal” style at the place where you want the
artwork to be, select the “Insert” “Picture” “From File…” command. In the “Insert Picture” dialogue box, type in the
file name in the “File name” field or select it from the list and click on the “Elements” button. (If the file name does
not appear in the list, open the drop-down list of the “Look in” field, and select the appropriate disk drive, directory
or folder.)
By default, Word embeds pictures (images) in a document. You can reduce the size of a document by linking the
pictures (images) as described here. In the “Insert” menu select “Picture” and then “From File…”. In the “Insert
Picture” dialogue box, select the picture you wish to insert and then proceed as follows: in Word 97 check the box
“Link to File” and then deselect the box “Save with document”; in Word 2000 click the arrow to the right of the
“Elements” button, and then click “Link to File”. If the source file of the picture is available, then the word processor
displays the picture based on the data from the source file but does not store the picture as part of the document
file. Each time the word processor shows the picture, the screen image is produced from the source file.
Consequently, it takes longer to display the linked picture file than it would if it were directly stored in the document
file but, by proceeding in this manner, the size of the document file does not substantially increase. You can use
the F9 key to update the picture if you have altered it in the program that was used to create it. Note that you
cannot edit the picture using Word, although you can see it in your document and print it when you print your
document. If the source file of the picture is not available, then only an empty box appears on the screen.
NOTE

Experience has shown that EPS and TIFF are the best image (graphics) formats for importation into Word.

It is recommended to store the pictures (graphics files) in the same folder as the associated document file and to
link them using relative links as described above (i.e. the location of the graphics files is defined with respect to the
location of the document file) so that the links remain valid when the document is exchanged. The ITSIG Guide[19]
provides additional information.
When sending files to the ISO Central Secretariat, you may simply send us a copy of the folder containing the
document file (with relative links to the graphics files) and the graphics files.
5.3.10.3

Notes to figures

5.3.10.3.1 Drafting rules
Notes to figures shall be treated independently from notes integrated in the text. They shall be located above the
designation of the relevant figure and shall precede figure footnotes. A single note in a figure shall be preceded by
“NOTE”, placed at the beginning of the first line of the text of the note. When several notes occur in the same
figure, they shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. A separate numbering sequence shall be
used for each figure.
Notes to figures shall not contain requirements or any information considered indispensable for the use of the
document. Any requirements relating to the content of a figure shall be given in the text, in a footnote to the figure
or as a paragraph between the figure and its title. It is not necessary that notes to figures be referred to.
5.3.10.3.2 Style
Name: Note
Automatic numbering: no
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5.3.10.3.3 Applying the style
Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Note” from the menu.
5.3.10.3.4 Remarks
See 5.3.7.4.
5.3.10.4

Figure footnotes

5.3.10.4.1 Drafting rules
Footnotes to figures shall be treated independently from footnotes to the text. They shall be located immediately
above the designation of the relevant figure.
Footnotes to figures shall be distinguished by superscript lower case letters, beginning with “a”. The footnotes shall
be referred to in the figure by inserting the same superscript lower case letter. See the Example in 5.3.10.5.4.
Footnotes to figures may contain requirements. As a consequence, it is particularly important when drafting the text
of the figure footnote to distinguish clearly between different types of provision by using the appropriate verbal
forms (see the ISO/IEC Directives, Part 2, 2001[1], Annex G).
5.3.10.4.2 Style
Name: Figure footnote
Automatic numbering: no
5.3.10.4.3 Applying the style
Position the cursor in an empty paragraph at the place where you want the figure footnote to be, select the style
‘‘Figure footnote” from the Style drop-down list, and then type in the footnote identification letter, insert a tabulation
and type in the text of the footnote. Select the footnote identification letter that you have just inserted, then from the
“Format” menu select “Font...” and in the “Font...” tab set the “Size” to 8 pt. Click on the tab “Character Spacing”
and in the “Position” drop-down list select “Raised” and set the value to 3 pt. Click on “OK”.
5.3.10.4.4 Remarks
Hitting return after you have entered a figure footnote will put the cursor in a new paragraph in the style “Figure
footnote”.
5.3.10.5

Figure designation and title

5.3.10.5.1 Drafting rules
Figures shall be designated “Figure” and numbered with Arabic numerals, beginning with 1. This numbering shall
be independent of the numbering of the clauses and of any tables. A single figure shall be designated “Figure 1”.
The numbering shall be continuous up to but excluding any annexes. Numbers given to the figures of an annex
shall be preceded by the letter designating that annex followed by a full-stop. The numbering shall start afresh with
each annex.
The figure designation and title (if present) shall be centred horizontally below the figure. The figure designation
and title shall be separated by a dash.
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5.3.10.5.2 Style
Name: Figure title
Automatic numbering: yes
5.3.10.5.3 Applying the style
Position the cursor in an empty paragraph in “Normal” style or at the beginning of the paragraph where the style is
to be applied. Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the
mouse to display the contextual menu, and select “Figure title” from the menu. If necessary, type the title and click
on the “OK” button.
5.3.10.5.4 Remarks
If a figure designation and title is restyled to any other style, the text “Figure x —” remains and will need to be
deleted if it is not applicable.
If for any reason the figure number is not correct, it can be updated using the F9 key.
The use of figure titles shall be uniform.
Hitting return after you have entered a figure title will put the cursor in a new paragraph in the style “Normal”.
EXAMPLE
Dimensions in millimetres

Key
1

description

2

description

A paragraph containing a requirement.
NOTE

Figure note.

a

Figure footnote.

b

Figure footnote.

Figure 1 — Figure title

5.3.11 Tables
5.3.11.1

Drafting rules

Tables should be used when they are the most efficient means of presenting information in an easily
comprehensible form. It shall be possible to refer to each table explicitly within the text.
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A table within a table is not permitted. Subdivision of a table into subsidiary tables is not permitted.
5.3.11.2

Table designation and title

5.3.11.2.1 Drafting rules
Tables shall be designated “Table” and numbered with Arabic numerals, beginning with 1. This numbering shall be
independent of the numbering of the clauses and of any figures. A single table shall be designated “Table 1”. The
numbering shall be continuous up to but excluding any annexes. Numbers given to the tables of an annex shall be
preceded by the letter designating that annex followed by a full-stop. The numbering shall start afresh with each
annex.
The table designation and title (if present) shall be centred horizontally above the table. The table designation and
title shall be separated by a dash.
5.3.11.2.2 Style
Name: Table title
Automatic numbering: yes
5.3.11.2.3 Applying the style
Position the cursor in an empty paragraph in “Normal” style or at the beginning of the paragraph where the style is
to be applied. Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the
mouse to display the contextual menu, and select “Table title” from the menu. If necessary, type the title and click
on the “OK” button.
5.3.11.2.4 Remarks
If a table designation and title is restyled to any other style, the text “Table x —” remains and will need to be deleted
if it is not applicable.
If for any reason the table number is not correct, it can be updated using the F9 key.
The use of table titles shall be uniform.
Hitting return after you have entered a table title will put the cursor in a new paragraph in the style “Normal”.
When a table is continued over two or more pages, it is not necessary to repeat the table number on each page
after the first if your word processor does not allow you to do so automatically.
5.3.11.3

Table content

5.3.11.3.1 Drafting rules
The first word in the heading of each column or row shall begin with a capital letter. The units used in a given
column shall generally be indicated under the column heading.
EXAMPLE 1
Type

Linear density
kg/m
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As an exception to this rule, when all units are the same, a suitable statement (for example, “Dimensions in
millimetres”) shall instead be placed above the right-hand corner of the table.
EXAMPLE 2
Dimensions in millimetres

Type

Length

Inside diameter

Outside diameter

The presentation shown in Example 3 is not permitted and shall be altered as shown in Example 4.
EXAMPLE 3
Types
A

B

C

Dimensions

EXAMPLE 4
Types
Dimensions
A

B

C

When a table is continued over several pages, the column headings together with any statement concerning units
shall be repeated on all pages after the first (see the procedure in 5.3.11.3.4).
5.3.11.3.2 Styles
Names: Table text (7) to Table text (10)
Automatic numbering: no
5.3.11.3.3 Applying the style
Select the appropriate style from the Style drop-down list.
5.3.11.3.4 Remarks
The “Normal” style is not appropriate for tables because the text touches the upper border of the table cells.
Therefore, the “Table text” styles have been defined to centre text vertically in the table cells. The font sizes of the
styles are as follows:
Table text (9): 9 pt
Table text (8): 8 pt
Table text (7): 7 pt
Table text (10): 10 pt
Table text (9) is the recommended style. Table text (8) and Table text (7) should be used for large tables. For
aesthetic reasons, it is not recommended to use Table text (10).
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Use the “Bold” or “Italic” formatting button of your word processor to produce the required formatting; do not use a
bold or sloping font.
Create a table using the table functionality of your word processor. As a rule, do not insert large tables from
spreadsheets as images or objects. Insert them preferably as a table or as text in the text file (for the way in which
to proceed, consult the on-line help or user manual of your word processor). Then, convert all the data to a table, if
they are not already in this format, and apply the appropriate styles to the different table elements. Contact the ISO
Central Secretariat if you have any styling problems using the word processor.
Any statement concerning the dimensions used should be placed in a “Normal” style paragraph. Use the formatting
command of your word processor to align the paragraph with the right-hand side of the table, and to reduce the font
size by one point.
When a table is continued over two or more pages, select the column heading(s) on the first page and, then select
the “Headings” (Word 97) or the “Heading Rows Repeat” (Word 2000) command under the “Table” menu to repeat
automatically the heading(s) on the following pages.
It is not possible to use the styles “Heading 1” to “Heading 6”, and “a2” to “a6” in tables.
5.3.11.4

Notes to tables

5.3.11.4.1 Drafting rules
Notes to tables shall be treated independently from notes integrated in the text. They shall be located within the
frame of the relevant table and shall precede table footnotes. A single note in a table shall be preceded by “NOTE”,
placed at the beginning of the first line of the text of the note. When several notes occur in the same table, they
shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. A separate numbering sequence shall be used for each
table.
Notes to tables shall not contain requirements or any information considered indispensable for the use of the
document. Any requirements relating to the content of a table shall be given in the text, in a footnote to the table or
as a paragraph within the table. It is not necessary that notes to tables are referred to.
5.3.11.4.2 Style
Name: Note
Automatic numbering: no
5.3.11.4.3 Applying the style
Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Note” from the menu.
5.3.11.4.4 Remarks
For tables with more than one column, it is necessary to merge the cells in which the table notes appear.
See also 5.3.7.4.
5.3.11.5

Table footnotes

5.3.11.5.1 Drafting rules
Footnotes to tables shall be treated independently from footnotes to the text. They shall be located within the frame
of the relevant table, and shall appear at the foot of the table.
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Footnotes to tables shall be distinguished by superscript lower case letters, beginning with “a”. The footnotes shall
be referred to in the table by inserting the same superscript lower case letter. See the Example in 5.3.11.5.4.
Footnotes to tables may contain requirements. As a consequence, it is particularly important when drafting the text
of the table footnote to distinguish clearly between different types of provision by using the appropriate verbal forms
(see the ISO/IEC Directives, Part 2, 2001[1], Annex G).
5.3.11.5.2 Style
Name: Table footnote
Automatic numbering: no
5.3.11.5.3 Applying the style
Position the cursor at the place in the table where the table footnote reference is to be inserted, then either click on
the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display the contextual
menu, and select “Table footnote” from the menu. Type in the identification letter of the footnote and click on the
“OK” button. A new row will be created at the foot of the table — if the table contains more than one column, the
cells in this row will be merged to form a single cell. The identification letter of the footnote will appear at the lefthand side of this new row, and the cursor will be positioned ready for you to type in the text of the footnote.
5.3.11.5.4 Remarks
Table footnotes will appear at the foot of the table in the order in which they are inserted. Therefore, it is necessary
to insert the footnotes in the correct order.
If a reference to a table footnote needs to appear more than once within the table, use the method described in
5.3.11.5.3 only for the first reference. For the other references, simply copy the first reference inserted and paste it
as many times as appropriate.
Hitting return after you have entered a table footnote will put the cursor in a new paragraph in the style “Table
footnote”.
EXAMPLE
Dimensions in millimetres

Type

Length

Inside diameter

l1 a

d1

l2

d2 b c

Outside diameter

A paragraph containing a requirement.
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NOTE 1

Table note.

NOTE 2

Table note.

a

Table footnote.

b

Table footnote.

c

Table footnote.
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5.3.12 Cross-references
5.3.12.1

Cross-references to automatically numbered elements

It is possible to cross-reference most automatically numbered elements using the “Insert” “Cross-reference…”
command and by selecting the appropriate category of cross-reference (see your software on-line help or user
manual for details how to do this). For the particular cases of insertion of a cross-reference to a footnote to the text
or to a bibliographic reference, see 5.3.9.4 and 5.3.15.3.3 respectively.
It is not permissible to make cross-references to page numbers.
NOTE 1
It is our experience that Word does not always manage cross-references correctly; take care that cross-references
are up to date in drafts that you receive.
NOTE 2
In certain cases, it is necessary to type in the term corresponding to the element (for example “Clause”, “list item”,
etc.) or the figure or table number.

5.3.12.2

Cross-references to elements which are not automatically numbered

5.3.12.2.1 Cross-references to terms defined in the document
Use the character style “Defterms” from the Style drop-down list to identify all cross-references in the document to
terms defined in the “Terms and definitions” clause.
5.3.12.2.2 Cross-references to a normative document
Use the character style “ExtXref” from the Style drop-down list to identify in the document all cross-references to
normative references defined in the “Normative references” clause.
5.3.12.2.3 Cross-references to other elements which are not automatically numbered
It is possible to use Bookmarks and Fields to create cross-references to other elements which are not numbered
automatically (for the way in which to proceed, consult the on-line help or user manual of your word processor).
Use Bookmarks only for those elements which are not automatically numbered by the template. Cross-references
to page numbers are not permissible.
5.3.13 Displayed mathematical and chemical formulae
5.3.13.1

Drafting rules

Equations between quantities are preferred to equations between numerical values (see the ISO/IEC Directives,
Part 2, 2001[1], 6.6.10.1). Equations shall be expressed in mathematically correct form, the variables being
represented by letter symbols the meanings of which are explained in connection with the equations, unless they
appear in a “Symbols and abbreviated terms” clause (see the ISO/IEC Directives, Part 2, 2001[1], 6.3.2).
Descriptive terms or names of quantities shall not be arranged in the form of an equation. Names of quantities or
multiletter abbreviated terms, for example presented in italics or with subscripts, shall not be used in the place of
symbols.
If it is necessary to number some or all of the formulae in a document in order to facilitate cross-reference, Arabic
numbers in parentheses shall be used, beginning with 1. The numbering shall be continuous and independent of
the numbering of clauses, tables and figures. Subdivision of formulae [e.g. (2a), (2b), etc.] is not permitted.
Numbers given to the mathematical formulae of an annex shall be preceded by the letter designating that annex
followed by a full-stop. The numbering shall start afresh with each annex.
The International System of units (SI) as set out in ISO 31[7] shall be used. Symbols for quantities shall be chosen,
wherever possible, from the various parts of ISO 31 and IEC 60027[17]. For further guidance on application, see
ISO 1000[18].
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The units in which any values are expressed shall be indicated.
The decimal sign shall be a comma on the line in all language versions.
For clarity, the symbol × rather than a point shall be used to indicate multiplication of numbers and numerical
values.
If a value less than 1 is written in decimal form, the decimal sign shall be preceded by a zero.
For further information, see the ISO/IEC Directives, Part 2, 2001[1], 6.6.8 to 6.6.11.
5.3.13.2

Style

Name: Formula
Automatic numbering: no
5.3.13.3

Applying the style

Either click on the “Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display
the contextual menu, and select “Formula” from the menu.
5.3.13.4

Remarks

When “Formula” is selected from either the “Elements” button menu or the contextual menu, the “Formula” style is
applied to the paragraph in which the cursor is placed and then the Microsoft Equation 3.0 supplied with Word 97
and Word 2000 is started automatically. This style is reserved for displayed formulae.
If you want to number a formula, after having closed Microsoft Equation, insert a tabulation after the formula, then
type in the number of the formula in parentheses.
Hitting return after you have entered a displayed formula will put the cursor in a new paragraph in the style
“Normal”.
Customize Microsoft Equation using the parameters given in the ITSIG Guide[19].
For lists of variables, use the “Normal” style for the word “where” and the “dl” style (description list) from the Style
drop-down list for each variable. Enter the variable (see 5.3.14) and insert a tabulation before the description. If
necessary, the indentation may be increased by increments of 20 pt.
5.3.14 Symbols and numbers
Symbols and numbers shall be presented in accordance with the following typographic rules:


function: roman character (upright);



variable (Latin or Greek letter): italic character;



symbol: roman character (upright);



matrix-vector: bold italic character;



text, numbers: roman character (upright).

As an exception, when a variable is written as an abbreviated term, abbreviation or acronym, it shall be in roman
characters (upright).
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The format of the character depends on its function (function, variable, symbol, matrix-vector, text or number) and
not on its position (i.e. on the line, subscript or superscript).
ISO 31-0[7] provides additional recommendations for the printing of symbols and numbers.
The template includes a tool to aid the composition of symbols for quantities (comprising Latin or Greek letters),
functions and numbers without having to use the equation editor. This tool, which is set up in accordance with the
equation editor settings given in the ITSIG Guide[19], automatically adapts the size of the symbols and their
subscripts and superscripts to the surrounding text.
To access this tool, position the cursor at the location where you want to insert the symbol(s). Either click on the
“Elements” button of the STD toolbar, or click on the right-hand button of the mouse to display the contextual menu,
and select “Symbol” to open the “Symbol” dialogue box (see Figure 10).
The “Maths” tab permits the insertion of symbols comprising Latin letters and numbers. Type the letters or numbers
in the appropriate field (“Variable” or “Function/Number”) and then specify their style (“Normal”, “Superscript” or
“Subscript”). [See Figure 10a).] When the definition is complete, click on the “Elements” button.
You can only enter text in one of the two fields at any one time before clicking on the “Elements” button.
The “Lower case Greek” and “Upper case Greek” tabs permit the insertion of symbols comprising Greek letters.
Click on the letters to be inserted, specify their style (“Normal”, “Superscript” or “Subscript”) and then click on the
“Insert” button. [See Figure 10b).] When a letter is selected it is displayed in the lower left-hand corner of the tab. A
sequence of letters can be selected and the “Insert” button clicked only once provided that all the letters have the
same style. If different styles are required, it is necessary to click on the “Insert” button after each letter/style
combination has been specified.
The letters selected can be deleted from the tab display using the “<-” button. If a sequence of letters has been
selected, the “<-” button deletes one letter each time it is clicked. The “Clear” button deletes all the letters
displayed.
CAUTION — Since the style choice (“Normal”, “Superscript” or “Subscript”) applies to all the letters
selected in the same session, check that the style is correct before clicking on the “Insert” button. Note
that the last style chosen remains selected on the tab, and therefore check that the style corresponds to
your choice before you click on the “Insert” button.
Each time that you click on the “Insert” button the tool adds a space in the document after the inserted symbols;
this space may need to be deleted subsequently.
Once the symbols have been inserted in the document, they can be modified using the formatting commands of
your word processor.
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a) “Maths” tab

b) “Lower case Greek” tab
Figure 10 — “Symbol” dialogue box
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5.3.15 Bibliography
5.3.15.1

Drafting rules

A Bibliography, if present, shall appear after the last annex. The relevant rules set out in ISO 690[20] shall be
followed.
The bibliography may include


referenced documents which are not publicly available,



referenced documents which are only cited in an informative manner, and



referenced documents which have merely served as bibliographic or background material in the preparation of
the document.

For online referenced documents, information sufficient to identify and locate the source shall be provided.
Preferably, the primary source of the referenced document should be cited, in order to ensure traceability.
Furthermore, the reference should, as far as possible, remain valid for the expected life of the document. The
reference shall include the method of access to the referenced document and the full network address, with the
same punctuation and use of upper case and lower case letters as given in the source (see ISO 690-2[21]).
5.3.15.2

Title “Bibliography”

5.3.15.2.1 Style
Name: zzBiblio
Automatic numbering: no
5.3.15.2.2 Applying the style
Position the cursor in an empty paragraph in “Normal” style at the location where you want to introduce the
bibliography, from the “Framework element” menu [opened by clicking on the “Elements” button of the STD toolbar
(see 4.4)], select “Bibliography”, click on the “Add” button, then click on the “OK” button.
5.3.15.2.3 Remarks
This style applies only to the title of the bibliography. Each reference in the bibliography is styled “bibliography”
(see 5.3.15.3).
5.3.15.3

Bibliographic references

5.3.15.3.1 Style
Name: bibliography
Automatic numbering: yes
5.3.15.3.2 Applying the style
Select the style from the Style drop-down list.
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5.3.15.3.3 Remarks
Each reference is numbered with Arabic numbers in square brackets. (These numbers can be used for crossreferencing elsewhere in the document.) The references may be given in numerical order or in the order of
appearance in the text.
To insert a cross-reference to a bibliographic reference, ensure first that the reference has been inserted using the
“bibliography” style. Position the cursor at the place where the cross-reference is to be inserted. In the “Insert”
menu select “Cross-reference...”. In the “Cross-reference” dialogue box select under “Reference type:” “Numbered
item” and select under “Insert reference to:” “Paragraph number”. In the list “For which numbered item” select the
bibliographic reference to which you want to refer. Click on the “Elements” button and then on the “Close” button.
Select the cross-reference that you have just inserted, then from the “Format” menu select “Font...” and in the
“Font...” tab set the “Size” to 8 pt. Click on the tab “Character Spacing” and in the “Position” drop-down list select
“Raised” and set the value to 3 pt. Click on “OK”.
5.3.16 Index
5.3.16.1

Drafting rules

Indexes, if present, shall appear as the last element.
5.3.16.2

Title “Index”

5.3.16.2.1 Style
Name: zzIndex
Automatic numbering: no
5.3.16.2.2 Applying the style
Position the cursor in an empty paragraph in “Normal” style at the location where you want to introduce the index,
from the “Framework element” menu [opened by clicking on the “Elements” button of the STD toolbar (see 4.4)],
select “Index”, click on the “Add” button, then click on the “OK” button.
5.3.16.2.3 Remarks
This style applies only to the title of the index. Each entry in the index is styled “Index 1” (see 5.3.16.3).
5.3.16.3

Index entries

5.3.16.3.1 Style
Name: Index 1
Automatic numbering: no
5.3.16.3.2 Applying the style
Automatically applied to index entries.
5.3.16.3.3 Remarks
Indexes should preferably be generated automatically. Authors of non-terminology standards wanting to introduce
indexes are invited to contact the ISO Central Secretariat to discuss the best means of generating an index.
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Do not forget to update the index when you have finished drafting your document and before you print it: put the
cursor anywhere in the index and press the F9 key. Beware that the index may not be up to date in drafts you
receive.
Before inserting an index using the “Index and Tables...” command in the “Insert” menu, it is essential to add a new
section to prevent the page setup of the previous sections from being altered. Therefore, to insert an index proceed
as follows. Place the cursor at the end of the page preceding the title “Index” (see 5.3.16.2.2) and from the “Insert”
menu select “Break…”. In the “Break” dialogue box, select “Next page” under the option “Section breaks”. To
correct the headers and footers in this new section position the cursor somewhere in the index and from the “View”
menu, choose “Header and Footer”; in the “Header and Footer” toolbar, click on the “Page Setup” button and
deselect the check box “Different first page” in the “Layout” tab and click “OK”. Close the “Header and Footer”
toolbar. Choose “Page Numbers...” from the “Insert” menu. Click on “Format...” and select the page numbering
option “Continue from previous section”. Click twice on the “OK” button.
5.3.16.4

Index entry headings

5.3.16.4.1 Style
Name: Index Heading
Automatic numbering: yes
5.3.16.4.2 Applying the style
Automatically applied to index entry headings (but see 5.3.16.4.3).
5.3.16.4.3 Remarks
The index entry headings are not inserted automatically when an index is inserted having the “template” format. For
further information, see B.1.8.
5.3.17 Other elements
5.3.17.1

Style

Name: Special
Automatic numbering: no
5.3.17.2

Applying the style

Select it from the Style drop-down list.
5.3.17.3

Remarks

Use the “Special” style for any element of text for which you are unsure as to the correct style to use, or for which
you feel that none of the styles contained in the stylesheet is appropriate. Note that if you create your own style(s),
they will be mapped to “Special” on exportation/importation.
Hitting return after you have entered a component styled as “Special” will put the cursor in a new paragraph in the
style “Normal”.
The template has a function which facilitates the creation of designations (see Example 1) and warning notices
(danger, warning, caution, important, safety regulations). Either click on the “Elements” button of the STD toolbar,
or click on the right-hand button of the mouse to display the contextual menu, and select “Designation” or “Warning
notice” from the menu.
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EXAMPLE 1
Throwaway insert ISO xyz-TPGN160308-EN-P20
EXAMPLE 2
<<<<< Data packet exchange >>>>>
<-----------|CONNECT|
|CONNAck|---------->
<-----------|CONTOdd|
|Ack|---------->
<<<<< End of map session >>>>>

5.4

Other styles

5.4.1
5.4.1.1

Header
Style

Name: Header
Automatic numbering: no
5.4.1.2

Applying the style

Element inserted by the template.
5.4.1.3

Remarks

The headers are generated from the data entered in the STD manager. Therefore, changes to the headers shall be
made only by changing the data in the STD manager; click on the “Doc.Info” button (see 4.2) and add or change
the data in the relevant dialogue box.
If the page layout necessitates the creation of a new section (see 5.1), from the “View” menu, choose “Header and
Footer”; in the “Header and Footer” toolbar, click on the “Page Setup” button and deselect the check box “Different
first page” in the “Layout” tab and click “OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...”
from the “Insert” menu. Click on “Format...” and select the page numbering option “Continue from previous section”.
Click twice on the “OK” button. (See also 5.4.2.)
5.4.2
5.4.2.1

Footer
Style

Name: Footer
Automatic numbering: no
5.4.2.2

Applying the style

Element inserted by the template.
5.4.2.3

Remarks

The footer is generated from the data entered in the STD manager. Therefore, changes to the footer shall be made
only by changing the data in the STD manager; click on the “Doc.Info” button (see 4.2) and add or change the data
in the relevant dialogue box.
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If the page layout necessitates the creation of a new section (see 5.1), from the “View” menu, choose “Header and
Footer”; in the “Header and Footer” toolbar, click on the “Page Setup” button and deselect the check box “Different
first page” in the “Layout” tab and click “OK”. Close the “Header and Footer” toolbar. Choose “Page Numbers...”
from the “Insert” menu. Click on “Format...” and select the page numbering option “Continue from previous section”.
Click twice on the “OK” button. (See also 5.4.1.)
5.4.3
5.4.3.1

Help
Style

Name: zzHelp
Automatic numbering: no
5.4.3.2

Applying the style

Element inserted by the template.
5.4.3.3

Remarks

The help text in “zzHelp” style only appears if the “Include notes on drafting” check box is selected in the second
dialogue box of the STD manager (see item 5 in Figure 5). It is necessary to delete these notes before finalizing
your document.
NOTE
Whichever options are entered in the STD manager when the document is created (i.e. whichever document type is
selected, whether the document is a part or not, whichever organization is selected, etc.), the notes concerning editorial drafting
rules and the document skeleton inserted apply to an ISO International Standard.

© ISO 2002 – All rights reserved

51

STD template, version 2.1

Annex A
(informative)
ISO templates

Template name

Operating system

Word processor

Remarks

Windows 3.1

Word 6

—

Windows 95

Word 95

Windows 95

Word 97

•

Test version
STD 1.0

Word 97

•

Replaces ISOSTD33

•

Replaced by STD 2.0

Automated templates (Wizard)
ISOSTD30

ISOSTD33

Windows NT4.0
STD 1.0

Windows 95
Windows 98

replaced

by

Windows NT4.0
STD 2.0

Windows 95

Word 97

•

Replaces STD 1.0

Windows 98

Word 2000

•

Compliant with the ISO/IEC
Directives, Part 3, 1997

•

Replaced by STD 2.1

Windows Me
Windows NT4.0
Windows 2000
STD 2.1

Windows 95

Word 97

•

Replaces STD 2.0

Windows 98

Word 2000

•

Windows Me

Word XP (2002)

Compliant with the ISO/IEC
Directives, Part 2, 2001

Developed for Word 6 but
works with any word
processor

•

Saved as Word 6 format

•

Replaced by BASICEN2 and
BASICFR2

Any word processor a

•

Available as both a Word
template (extension .DOT)
and in rich text format
(extension .RTF) a

•

Replaced by BASICEN3 and
BASICFR3

•

Available as both a Word
template (extension .DOT)
and in rich text format
(extension .RTF) a

•

Replaces BASICEN2
BASICFR2

Windows NT4.0
Windows 2000
Windows XP
Basic templates (no automated features)
BASICEN

Any operating system

BASICFR
BASICEN2

Any operating system

BASICFR2

BASICEN3

Any operating system

Any word processor a

BASICFR3

NOTE
a
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and

The various ISO templates are designed to be upwards compatible.

If your word processor cannot open Word templates (extension .DOT), use the Word document (extension .RTF).
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Annex B
(normative)
Known problems and their solutions

B.1 Problems related to use of the template
No.

Problem

Solution

B.1.1

The message “Method 'PrivateProfileString' of object The template requires write access to the STD.INI file.
'System' failed” appears after running Doc.Info or after Contact your network administrator to allow writing to the
clicking on the “Options” button of the STD toolbar.
Windows folder of your computer (see Clause 1).

B.1.2

The presentation of the List number and List Continue This is caused by parasitic tabulations which appear
styles is not always correct.
when certain levels of list style are applied: to resolve the
problem, select the paragraph in which the problem
occurs and in the “Format” menu select the “Tabs...”
command. Click on the “Clear all” command, then set a
tabulation at 20 pt for level 1, 40 pt for level 2, 60 pt for
level 3 and 80 pt for level 4.

B.1.3

Figure and table numbers do not appear when a cross- In the “Cross-reference” dialogue box, in the “Insert
reference is inserted using the “Cross-reference…” reference to:” drop-down list, select “Only label and
command of the “Insert” menu.
number”, click on the “Elements” button and close the
dialogue box. Insert the figure or table number manually,
preceded by a nonbreaking space.

B.1.4

An error message occurs in the titles of figures and This problem occurs in linguistic versions of Word other
tables in annexes.
than English and French; position the cursor above the
error message, click on the right-hand button of the
mouse and select the check box “Display field codes”;
replace the switch “ALPHABETIC” by its equivalent in
your linguistic version (e.g. “ALPHABÉTIQUE” in French);
position the cursor again above the field, click on the
right-hand button of the mouse and select “Update fields”.

B.1.5

When a new table or a figure is inserted before an Select the number to be updated and click on F9. If this
existing table or figure, the numbering of the existing table does not work, reapply the appropriate style.
or figure is not updated automatically.

B.1.6

The generated text of notes, examples, warning
notices, figures and tables inserted using the
“Elements” button of the STD toolbar does not appear in
the document language.

B.1.7

One of the elements of the document title has been Do not use quotation marks in document titles: replace
truncated and the following elements are missing or have them with two apostrophes (see also 4.2.2).
been replaced by the beginning of the truncated element.

B.1.8

The index entry headings are not inserted automatically This will be corrected in a future version. Select a
when the index is inserted having the “template” format.
predefined index format which includes index entry
headings.

B.1.9

On the cover sheet, the first line (series number) and the Do not alter this. It will be corrected in a future version.
fourth line (TC/SC/WG reference) specify “ISO TC”
instead of “ISO/TC” when the organization is “ISO”.

© ISO 2002 – All rights reserved

This text appears in French if the paragraph language is
French, in German if it is German and in English for all
other languages. Select the element concerned and
modify the paragraph language by setting the language in
the “Language” “Set Language...” command in the “Tools”
menu.
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No.

Problem

Solution

B.1.10

The title of the amendment or technical corrigendum is It is possible to add “AMENDMENT” or “TECHNICAL
not shown after the document title on page 1 and on the CORRIGENDUM”, as well as the title of the amendment
cover sheet.
or technical corrigendum: position the cursor just before
the paragraph mark at the end of the document title on
the cover sheet, hit return and type in the text required.
Proceed in the same manner on page 1.

B.1.11

The “Scope” title appears on page 1 of an amendment or Delete it.
technical corrigendum.

B.1.12

The text in the foreword has been modified.

B.1.13

The text “Part n”, “Part n+1” appears once or several This text is inserted automatically every time the STD
times in the list of part titles of the foreword.
manager is run. Delete what is not applicable.

B.1.14

The style area is not displayed as it is in the ISOSTD30 Usually just select the “Normal” view (“Normal” command
template.
in the “View” menu). If the style area is still not displayed,
choose the “Options…” command in the “Tools” menu
and then the “View” tab. Adjust the value of the “Style
area width” field as required and click on the “OK” button.

B.1.15

An error message appears at the place where the page Word cannot correctly interpret certain switches in the
number should be in the footer.
field codes: choose the “Header and Footer” command in
the “View” menu, display the footer, position the cursor
above the error message, click on the right button of the
mouse and select “Display field codes”; replace the
switches “ROMAN”, “LOWER” and “ARABIC” by their
equivalent in your linguistic version (e.g. in French they
are “ROMAIN”, “MINUSCULE” and “ARABE”); position
the cursor above the field, click on the right button of the
mouse and select “Update field”.

B.1.16

The numbering suddenly becomes discontinuous or Save the file in RTF format using the “Save As...”
incorrect and certain elements no longer have their command of the “File” menu. Close Word. Open Word
correct presentation.
again, open the RTF file and save it in Word format using
the “Save As...” command of the “File” menu. Via the
“Track changes” command of the “Tools” menu, accept all
the changes and then in the “Highlight Changes”
dialogue box, deselect the option “Track changes while
editing”. Reapply the styles as necessary (see also
B.1.17).

B.1.17

Upon opening a file based on the template, certain styles In the “Tools” menu, choose the “Templates and
do not have the correct presentation (numbering wrong, Add-Ins...” command and verify that the checkbox
wrong indents, etc.).
“Automatically update document styles” is not selected. If
this is not the case, deselect it and confirm by clicking on
the “OK” button. Then reapply the template styles using
the “Style Gallery”: in the “Format” menu select “Theme”,
click on the “Style Gallery…” button (Word 2000) or select
directly “Style Gallery” (Word 97); in the “Template” box
select “STD” and click on the “OK” button.

B.1.18

Empty files based on the template are created by Word.

B.1.19

The list of available styles is more extensive than that Each time that the STD manager is run the complete set
indicated in this manual.
of Word predefined styles is added to the template. Do
not use these additional styles; delete them.

B.1.20

The template buttons are labelled in French
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The text of the foreword is automatically regenerated
every time the STD manager is run. See 5.3.4.3.3.

In certain configurations and when certain operations are
carried out using the template, or when the “Translation”
and “Importation” functions are used, the STD template
creates a new empty document. Delete such files.

Click on the “Options” button and change the language to
“Anglais”, then click on the “OK” button.
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No.

Problem

Solution

B.1.21

When inserting a note, an example or a warning notice
at the bottom of a cell in a table containing several
paragraphs, the automatic insertion (of the word “NOTE”,
“EXAMPLE”, “WARNING”, etc.) places the inserted text at
the beginning of the first paragraph in the cell and not at
the beginning of the paragraph concerned.

Do not use the “Insert” functionality. Instead apply these
styles using the drop-down list of styles, and then type in
the word “NOTE”, “EXAMPLE”, “WARNING”, etc. at the
beginning of the paragraph.

B.2 Problems related to saving and managing files
No.

Problem

Solution

B.2.1

When saving a document, the “Cancel” button does not This is a feature built into the template.
work.

B.2.2

When opening the file, the “Standardization system” This will be corrected in a future version. See 4.3.3.
dialogue box is grey.

B.2.3

When opening the file, a Microsoft Visual Basic window The file is certainly based on the MDN template (see the
opens.
text at the bottom of the cover sheet). Close the Visual
Basic window, then open a new document based on the
STD template, enter the relevant data into the STD
manager and cut all the text following the “Scope” clause
in the original document. Paste this text into a suitable
location in the newly created document. Proceed in the
same manner for the foreword and introduction, as
necessary.

B.2.4

The document to be synchronized is created but the This problem only occurs in certain configurations. Do not
administrative information is not updated.
use the “Synchronization” function (see related problem in
B.2.5).

B.2.5

When running the STD manager, another document The document that opens was previously synchronized
based on the template opens.
with the current document for which you are running the
STD manager. Do not use the “Synchronization” function
(see related problem in B.2.4).

B.3 Problems related to the importation of documents created using the ISOSTD30 and
ISOSTD33 templates
No.

Problem

Solution

B.3.1

The document type “Technical Report” is not recognized Select it manually from the drop-down list in the STD
when imported.
manager when importing the file.

B.3.2

Importing a document creates a second table of Delete one of the two tables of contents.
contents.

B.3.3

The entry levels of the table of contents are not the Alter the levels as required. See 5.3.3.3.3.
same as those of the original document.

B.3.4

The styles for a list are not correctly applied.

In the ISOSTD30 and ISOSTD33 templates, only the “List
Continue” style is the same as that in the STD template.
Manually apply the required style.

B.3.5

The numbering of the titles is incorrect.

Check that the correct styles have been applied then
close the document and re-open it.

B.3.6

The document type and reference number of the Enter them manually in the STD manager when importing
document are not recovered when importing documents the file.
prepared using ISOSTD33.

B.3.7

The SEQ fields of table and figure footnotes of This will be corrected in a future version.
documents prepared using ISOSTD33 are not correctly
translated.
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No.

Problem

Solution

B.3.8

The foreword text is not always updated automatically.

Select the foreword text up to the parts list and apply the
“Foreword” style to this selection. See also 5.3.4.3.

B.3.9

The imported document contains only a cover sheet.

The original document consisted of only a single section.
Insert a section break at the bottom of the cover sheet
and another one after the introduction, and import the
document again.

B.3.10

The imported document contains only a cover sheet The original document consisted of only two sections.
and the preliminary informative section.
Insert the missing section break either at the bottom of
the cover sheet or after the introduction and import the
document again.

B.3.11

The landscape format sections in the original document Reformat these sections.
have been imported in a portrait format.

B.3.12

An error message appears in the titles of figures and Delete the text “FigureError! Unknown switch
tables in annexes.
argument. —”
or
“TableError!
Unknown
switch
argument. —” and reapply the style as in 5.3.10.5.3 and
5.3.11.2.3 respectively. For users of Word XP (2002), see
B.4.4.

B.3.13

The document is not imported but simply opened.

B.3.14

Upon opening a file based on the template, certain styles In the “Format” menu, choose the “Style...” command and
do not have the correct presentation (numbering wrong, click on the “Organizer...” button. In the “Organizer”
wrong indents, etc.).
dialogue box, select the “Styles” tab. Click on the “Close
File” button (bottom right), then on the “Open File” button.
Open the file STD.DOT. Select the set of styles in the list
on the right-side and click on the “Copy” button (from
STD.DOT towards your document). In answer to the
question in the Microsoft Word dialogue box “Do you wish
to overwrite the existing style entry a2?”, click on the
button “Yes to All”. Click on the “Close” button.

Create a new document based on the STD template and
enter the relevant administrative data in the STD
manager. Next, in the source document, cut all the text
following the scope and paste it into a suitable place in
the newly created template document. Follow the same
procedure for the foreword and introduction as necessary.

B.4 Problems connected with Word XP (2002)
No.

Problem

Solution

B.4.1

The message “Method 'PrivateProfileString' of object The template requires write access to the STD.INI file.
'System' failed” appears after running Doc.Info or after Contact your network administrator to allow writing to the
clicking on the “Options” button of the STD toolbar.
Windows folder of your computer (see Clause 1).

B.4.2

When using the buttons of the STD toolbar or when In the “Tools” menu, select “Options” and then the
opening a file created on a different PC, the error “Security” tab and click on the button “Macro Security”.
message 6068 (programmatic access to Visual Basic Select the “Trusted Sources” tab and check the boxes
“Trust all installed add-ins and templates” and “Trust
Projects is not trusted) appears.
access to Visual Basic Project”.

B.4.3

Inserted footnotes do not have the correct presentation.

B.4.4

An error message occurs in the titles of figures and Position the cursor above the error message, click on the
tables in annexes.
right-hand button of the mouse and select the check box
“Display field codes”; replace the switch “ALPHABETIC”
by its equivalent in your linguistic version (e.g.
“ALPHABÉTIQUE” in French); position the cursor again
above the field, click on the right-hand button of the
mouse and select “Update fields”.
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Insert footnotes using the “Elements” button of the STD
toolbar and not the “Insert” menu of the Standard toolbar.
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No.

B.4.5

Problem

Solution

In the “Standardization system” dialogue box of the This will be corrected in a future version.
Doc.Info the “Special character” button, after having been
activated to enter text into the TC or SC title field, remains
activated whichever field the cursor is put in.
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Annex C
(informative)
Summary of template styles

Contextual menu

Use

Other elements

Style name a

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

See

a2

Titles of annex clauses (for example A.1) — Automatically numbered

X

X

5.2.1

a3

Titles of annex subclauses, level 1 (for example A.1.1) — Automatically numbered

X

X

5.2.2.2

a4

Titles of annex subclauses, level 2 (for example A.1.1.1) — Automatically numbered

X

X

5.2.2.2

a5

Titles of annex subclauses, level 3 (for example A.1.1.1.1) — Automatically
numbered

X

X

5.2.2.2

a6

Titles of annex subclauses, level 4 (for example A.1.1.1.1.1) — Automatically
numbered

X

X

5.2.2.2

ANNEX

Heading, status and annex title — Automatically numbered

X

ANNEXN

Not used in ISO template

—

—

—

—

—

ANNEXZ

Not used in ISO template

—

—

—

—

—

bibliography

Reference entries in the bibliography

Default
Paragraph
Font*

Character style predefined in Word

—

—

Definition

Text of definitions

X

X

Defterms

Character style used to identify cross-references to terms defined in the “Terms and
definitions” clause

X

5.3.12.2

dl

Variables list (following a displayed formula)

X

5.3.13.4

Example

Examples

ExtXref

Character style used to identify cross-references to normative references defined in
the “Normative references” clause

X

5.3.12.2.2

Figure footnote

Figure footnotes

X

5.3.10.4

Figure title

Figure title — Automatically numbered

Footer*

Built-in style in Word for footers inserted using the “Header and Footer” command
from the “View” menu

Footnote
Reference*

Built-in character style in Word for references to footnotes, inserted using “Footnote”
from the “Elements” button menu

X

X

5.3.9.4

Footnote Text*

Built-in style in Word for footnote text inserted using “Footnote” from the “Elements”
button menu — Automatically numbered

X

X

5.3.9

Foreword

Foreword text automatically generated by the template

Formula

Displayed mathematical and chemical formulae

Header*

Built-in style in Word for a header inserted using the “Header and Footer” command
from the “View” menu

Heading 1*

Clause titles — Built-in style in Word — Automatically numbered

58

5.2.5

X
—

X

5.3.15.3
—

—

X

5.3.6.4.4

X

X

X
X

5.3.4.3
X

X
X

5.3.10.5
5.4.2

X
X

5.3.8

5.3.13
5.4.1

X

5.2.1
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Contextual menu

Use

Other elements

Style name a

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

See

Heading 2*

Subclause titles, level 1 — Built-in style in Word — Automatically numbered

X

X

5.2.2.2

Heading 3*

Subclause titles, level 2 — Built-in style in Word — Automatically numbered

X

X

5.2.2.2

Heading 4*

Subclause titles, level 3 — Built-in style in Word — Automatically numbered

X

X

5.2.2.2

Heading 5*

Subclause titles, level 4 — Built-in style in Word — Automatically numbered

X

X

5.2.2.2

Heading 6*

Subclause titles, level 5 — Built-in style in Word — Automatically numbered

X

X

5.2.2.2

Heading 7*

Built-in style in Word — Not used in the ISO template

—

—

—

—

—

Heading 8*

Built-in style in Word — Not used in the ISO template

—

—

—

—

—

Heading 9*

Built-in style in Word — Not used in the ISO template

—

—

—

—

—

Index 1*

Built-in style in Word for index entries

Index 2*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 3*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 4*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 5*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 6*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 7*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 8*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index 9*

Built-in style in Word for index subentries — Not used in the ISO template

—

—

—

—

—

Index Heading*

Built-in style in Word for index entry headings

X

5.3.16.4

Introduction

“Introduction” title

X

5.3.5.2

List Continue*

Unordered list items, level 1 — Automatically numbered

X

X

5.2.4.2

List Continue 2*

Unordered list items, level 2 — Automatically numbered

X

X

5.2.4.2

List Continue 3*

Unordered list items, level 3 — Automatically numbered

X

X

5.2.4.2

List Continue 4*

Unordered list items, level 4 — Automatically numbered

X

X

5.2.4.2

List Continue 5*

Built-in style in Word for unordered list items, level 5 — Not used in the ISO template

—

—

List Number*

Ordered list items, level 1 — Automatically numbered

X

X

5.2.4.3

List Number 2*

Ordered list items, level 2 — Automatically numbered

X

X

5.2.4.3

List Number 3*

Ordered list items, level 3 — Automatically numbered

X

X

5.2.4.3

List Number 4*

Ordered list items, level 4 — Automatically numbered

X

X

5.2.4.3

List Number 5*

Built-in style in Word for ordered list items, level 5 — Not used in the ISO template

—

—

—

—

—

MSDNFR

“Tool” style — Not used in the ISO template

—

—

—

—

—

na2

Not used in the ISO template

—

—

—

—

—

na3

Not used in the ISO template

—

—

—

—

—

na4

Not used in the ISO template

—

—

—

—

—

na5

Not used in the ISO template

—

—

—

—

—

na6

Not used in the ISO template

—

—

—

—

—

Normal*

Style by default predefined in Word for text
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X

—

—

—

X

5.3.16.3

5.2.3
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Note

Notes integrated in text, figures and tables

Page number*

Built-in character style in Word for page numbers automatically inserted using the
“Page Numbers” command

p2

Subclauses without titles, level 1

p3

See

X

5.3.7,
5.3.10.3,
5.3.11.4

—

—

X

X

5.2.2.3

Subclauses without titles, level 2

X

X

5.2.2.3

p4

Subclauses without titles, level 3

X

X

5.2.2.3

p5

Subclauses without titles, level 4

X

X

5.2.2.3

p6

Subclauses without titles, level 5

X

X

5.2.2.3

RefNorm

Normative references in the “Normative references” clause

Special

Style for text elements for which the correct style is not known with certainty or for
which no other template style is suitable

X

X

X

5.3.17

Table footnote

Table footnote text style

X

X

X

5.3.11.5

TableFootNoteXref

Character style for table footnote references and their identification letters

X

X

5.3.11.5

Table text (9)

Used for table texts (9 pt) (recommended)

X

5.3.11.3

Table text (8)

Used for table texts in large tables (8 pt)

X

5.3.11.3

Table text (7)

Used for table texts in very large tables (7 pt)

X

5.3.11.3

Table text (10)

Used for table texts (10 pt) (not recommended)

X

5.3.11.3

Table title

Table title — Automatically numbered

Term(s)

Terms defined in the “Terms and definitions” clause or in a terminology document

X

X

TermNum

Reference numbers of the terms defined in the “Terms and definitions” clause or in a
terminology document

X

X

TOC 1*

Table of contents entry, level 1 — Built-in style in Word

X

5.3.3.3

TOC 2*

Table of contents entry, level 2 — Built-in style in Word

X

5.3.3.3

TOC 3*

Table of contents entry, level 3 — Built-in style in Word

X

5.3.3.3

TOC 4*

Table of contents entry, level 4 — Built-in style in Word

X

5.3.3.3

TOC 5*

Table of contents entry, level 5 — Built-in style in Word

X

5.3.3.3

TOC 6*

Table of contents entry, level 6 — Built-in style in Word

X

5.3.3.3

TOC 7*

Built-in style in Word for table of contents entries

—

—

—

—

—

TOC 8*

Built-in style in Word for table of contents entries

—

—

—

—

—

TOC 9*

Table of contents entry for unnumbered elements

X

5.3.3.3

zzBiblio

“Bibliography” title

X

5.3.15.2

zzContents

“Contents” title

X

5.3.3.2

zzCopyright

Copyright notice

—

—

—

—

—

zzCover

Cover sheet of document

—

—

—

—

5.3.1

zzForeword

“Foreword” title

zzHelp

Editorial notes on drafting

60

X

Contextual menu

Use

Other elements

Style name a

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

—

—

X

—

X

X

5.3.6.3

X

5.3.6.4.3
X

X
—

—

5.3.11.2

—

5.3.6.4.2

5.3.4.2
—

5.4.3
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Contextual menu

Use

Other elements

Style name a

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

See

zzIndex

“Index” title

X

5.3.16.2

zzLc5

“Tool” style for numbering lists — Do not use

—

—

—

—

—

zzLc6

“Tool” style for numbering lists — Do not use

—

—

—

—

—

zzLn5

“Tool” style for numbering lists — Do not use

—

—

—

—

—

zzLn6

“Tool” style for numbering lists — Do not use

—

—

—

—

—

zzSTDTitle

Document title, on the first page of section 3

—

—

—

—

5.3.2

a

Style names marked with an asterisk are based on predefined Microsoft styles. These styles are recognized by the various linguistic
versions of Word and their names will be translated automatically into the language of the Word version which you are using. For these
Microsoft styles, the user will need to derive the correspondence between the name displayed and that given in this table; for example, if the
same document is opened using English and French versions of Word, text styled “Footnote Reference” in the English version is called “Appel
de note” in the French version.

b

The “Elements” button has certain automated functionalities associated with it (e.g. automatic inserts are programmed for certain styles).
Although the complete set of available template styles is also accessible via the Style drop-down list in the formatting toolbar and the “Style”
command of the “Format” menu, unless otherwise specified do not use these for applying styles since the automated features will be missing;
use the “Elements” button of the STD toolbar.
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Annex D
(informative)

Annex

heading, status and title

ANNEX

Bibliography

reference entry

bibliography

title

zzBiblio

Caution notice

X

Contextual menu

Any element of text for which the correct style to
Special
use is not known with certainty or for which no other
style of the template is suitable

Other elements

Style name a

Element

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

X

X

X
X

Automatic numbering

Which styles correspond to which elements — Quick reference guide

See

5.3.17

X

5.2.5

X

5.3.15.3

X

5.3.15.2

Special

X

X

body of document

Heading 1*

X

X

X

5.2.1

annexes

a2

X

X

X

5.2.1

Danger notice

Special

X

X

5.3.17.3

Definition

Definition

X

X

5.3.6.4.4

Designation

Special

X

X

5.3.17.3

formula

Formula

X

X

5.3.13

variables list

dl

Clause

Displayed
mathematical
and chemical
formulae
Example
Figure

Foreword
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X

5.3.13.4
X

5.3.8

footnote

Figure footnote

note

Note

X

X

5.3.10.3

title

Figure title

X

X

5.3.10.5

X

Figure footnote

5.3.10.4

X

5.3.10.4

reference

Footnote Reference*

X

X

text

Footnote Text*

X

X

text

Foreword

X

5.3.4.3

title

zzForeword

X

5.3.4.2

Important notice
Index

X

Example

Figure footnote
Footnote

X

5.3.17.3

Special
entry

Index 1*

entry heading

Index Heading*

“Index” title

zzIndex

X

X
X

X

5.3.9.4
5.3.9

5.3.17.3
5.3.16.3
5.3.16.4

X

5.3.16.2
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Introduction

List

text

Normal*

title

Introduction

ordered

Contextual menu

X

See

5.2.3

X

5.3.5.2

level 1

List Number*

X

X

X

5.2.4.3

level 2

List Number 2*

X

X

X

5.2.4.3

level 3

List Number 3*

X

X

X

5.2.4.3

level 4

List Number 4*

X

X

X

5.2.4.3

List Continue*

X

X

X

5.2.4.2

level 2

List Continue 2*

X

X

X

5.2.4.2

level 3

List Continue 3*

X

X

X

5.2.4.2

level 4

List Continue 4*

X

X

X

5.2.4.2

unordered level 1

Normative
reference

Other elements

Style name a

Element

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

Automatic numbering

STD template, version 2.1

cross-reference to a normative
reference defined in the
“Normative references” clause

ExtXref

in “Normative references” clause

RefNorm

X

X

5.3.12.2.2

X

5.3.6.1

Note integrated in text, figures and tables

Note

Paragraph

Normal*

Safety regulations notice

Special

X

X

5.3.17.3

Subclause
without title

level 1

p2

X

X

5.2.2.3

level 2

p3

X

X

5.2.2.3

level 3

p4

X

X

5.2.2.3

level 4

p5

X

X

5.2.2.3

level 5

p6

X

X

5.2.2.3

level 1

a3

X

X

X

5.2.2.2

level 2

a4

X

X

X

5.2.2.2

level 3

a5

X

X

X

5.2.2.2

level 4

a6

X

X

X

5.2.2.2

level 1

Heading 2*

X

X

X

5.2.2.2

level 2

Heading 3*

X

X

X

5.2.2.2

level 3

Heading 4*

X

X

X

5.2.2.2

level 4

Heading 5*

X

X

X

5.2.2.2

level 5

Heading 6*

X

X

X

5.2.2.2

Subclause
with title

annexes

body of
text

Symbols for quantities
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—

X

X

5.3.7, 5.3.10.3,
5.3.11.4

X

X

5.2.3

5.3.14
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Table

note

Note

table footnote
text

Table footnote

Table of
contents

Term

Warning notice

X

Contextual menu

Style name a

Other elements

Element

“Framework
element”

“Elements”
button

Style drop-down list

Apply using b

X

Automatic numbering

STD template, version 2.1

See

5.3.11.4

See Table footnote.

9 pt (recommended)

Table text (9)

X

5.3.11.3

8 pt, for large tables

Table text (8)

X

5.3.11.3

7 pt, for very large
tables

Table text (7)

X

5.3.11.3

10 pt (not
recommended)

Table text (10)

X

5.3.11.3

title

Table title

X

identification letter of the table
footnote

TableFootNoteXref

X

X

5.3.11.5

reference

TableFootNoteXref

X

X

5.3.11.5

text

Table footnote

X

X

5.3.11.5

“Contents” title

zzContents

X

5.3.3.2

level 1

TOC 1*

X

5.3.3.3

level 2

TOC 2*

X

5.3.3.3

level 3

TOC 3*

X

5.3.3.3

level 4

TOC 4*

X

5.3.3.3

level 5

TOC 5*

X

5.3.3.3

level 6

TOC 6*

X

5.3.3.3

unnumbered
elements

TOC 9*

X

5.3.3.3

entries

X

cross-reference to a term defined
in the “Terms and definitions”
clause

Defterms

in the “Terms and definitions”
clause in a terminology document

Term(s)

X

X

X

5.3.6.4.3

reference number

TermNum

X

X

X

5.3.6.4.2

X

X

5.3.17.3

Special

X

5.3.11.2

5.3.12.2

a

Style names marked with an asterisk are based on predefined Microsoft styles. These styles are recognized by the various linguistic
versions of Word and their names will be translated automatically into the language of the Word version which you are using. For these
Microsoft styles, the user will need to derive the correspondence between the name displayed and that given in this table; for example, if the
same document is opened using English and French versions of Word, text styled “Footnote Reference” in the English version is called
“Appel de note” in the French version.

b

The “Elements” button has certain automated functionalities associated with it (e.g. automatic inserts are programmed for certain styles).
Although the complete set of available template styles is also accessible via the Style drop-down list in the formatting toolbar and the “Style”
command of the “Format” menu, unless otherwise specified do not use these for applying styles since the automated features will be missing;
use the “Elements” button of the STD toolbar.
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Normative references ........ 27
Requirements ..................... 30

Contents title.............................. 23
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Cover sheet ................................ 21
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Creating documents .................... 5
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files
created using the STD
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synchronizing..................... 13
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End button.................................... 8
Example...................................... 33
Example menu item................... 33
Examples integrated in the text 33
numbering of...................... 34
Export button ............................... 3
ExtXref ........................................ 43

F
Fields .......................................... 43
Figure designation .................... 37
Figure footnote .......................... 37
references .......................... 37
Figure footnotes ........................ 37
Figure title ............................ 37, 38
Figure title menu item ............... 38
Figures........................................ 34
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Footer ......................................... 50
Footnote menu item .................. 34
Footnote references .................. 34
Footnotes to the text ................. 34
Foreword .............................. 24, 25
text ...................................... 25
title ...................................... 24
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Formula ...................................... 44
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Scope .................................. 26
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Clauses ....................................... 15
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Drawings..................................... 35

G

E

Green text..................................... 5

Editorial drafting rules
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Header ........................................ 50
Heading 1 ................................... 15
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system
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document,
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format
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Visual
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for
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titles, numbering is incorrect
......................................... 55
two tables of contents in a
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ANNEX ................................ 21
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ExtXref ................................ 43
Figure footnote .................. 37

wrong language of generated
text .................................. 53

Figure title .......................... 38
Footer ................................. 50

numbering of tables........... 53

R

Footnote Reference ........... 34
Footnote Text..................... 34

presentation of List number
style ................................. 53

Reagents..................................... 17
Red file name ............................. 13
Red text......................................... 5
Replaced documents................... 8
Replaced documents dialogue
box.............................................. 8
Requirements clause................. 30

reference
number
of
document not recovered55

S

Heading 1 ........................... 15

Sampling clause ........................ 31
Saving a file................................ 11
Saving files................................. 11
in a different format ........... 12

Heading 2 ........................... 16

page number error message
......................................... 54
presentation of List Continue
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saving a document............. 55
SEQ fields not correctly
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List Continue 3................... 19

TOC 9...................................23

List Continue 4................... 19

which styles correspond to
which elements...............62
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List Number 3..................... 19
zzCover .........................21, 22
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